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ΠΡΟΛΟΓΟΣ 

Σε αυτή τη πτυχιακή χρησιμοποιήθηκε κατά βάση το πρόγραμμα Adobe After 
Effects για να δημιουργήσουμε ένα σύντομο animation δίνοντας κίνηση σε στατικά 
γραφικά. 

Για να φτάσουμε στο τελικό αποτέλεσμα χρησιμοποιήθηκαν τα προγράμματα 
Adobe illustrator για τη δημιουργία των γραφικών και το πρόγραμμα Adobe After 
Effects για την δημιουργία κίνησης. Μέσω επιπρόσθετων ξεχωριστών plugin του 
After Effects θα επιτύχουμε να συνδέσουμε ξεχωριστά τα μέλη ενός χαρακτήρα και 
να αποδώσουμε κίνηση.  
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ΠΕΡΙΛΗΨΗ 

Σε αυτήν την πτυχιακή εργασία γίνεται αναφορά η ιστορική αναδρομή του 
animation, οι τεχνικές, οι εφαρμογές, τα στάδια παραγωγής και ο τρόπος δημιουργίας 
ενός σύντομου βίντεο 2d computer animation. Η δημιουργία των γραφικών έγινε με 
τη χρήση προγραμμάτων Adobe Illustrator CS6 και Adobe After effects CS6. Στη 
συνέχεια θα δοθεί κίνηση με το πρόγραμμα After Effects. Θα ακολουθήσει μια 
περιγραφή των βημάτων για την δημιουργία κάποιων κύριων σκηνών. 

ABSTRACT  

In this thesis, reference is made to the historical review of animation, 
techniques, utility, stages of production and the way of creating a short 2d computer 
animation. Graphics were created by using Adobe Illustrator CS6 and Adobe After 
Effects CS6 programs. Motion will be given with the After Effects program. A 
description will follow analyzing the steps of the creation  some of the main scenes . 

ΛΕΞΕΙΣ ΚΛΕΙΔΙΑ 

Animation, After Effects, Computer Animation, Ιστορική αναδρομή 
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ΕΙΣΑΓΩΓΗ 

Κύριος σκοπός αυτής της εργασίας είναι η πληροφόρηση και η προσέγγιση 
του κόσμου σχετικά με τον εντυπωσιακό ψηφιακό κόσμο των πολυμέσων αλλά και το 
εύρος των δυνατοτήτων τους. Δίνεται η δυνατότητα στο κοινό μέσω των 
προγραμμάτων να γνωρίσει τη μαγεία να μπορείς να διαμορφώνεις άλλες 
πραγματικότητες, το έναυσμα να ασχοληθεί με το αντικείμενο όπως επίσης και η 
επιθυμία παραγωγής πρωτότυπων έργων. Τέλος δίνεται η ευκαιρία να αντιληφθεί 
κανείς τα στάδια παραγωγής ενός animation και πως τα προγράμματα αυτά 
συντελούν στην δημιουργία του τελικού αποτελέσματος. 

Το θέμα αυτής της πτυχιακής είναι η ψηφιακή δημιουργία ενός σύντομου 
βίντεο animation και η αναλυτική επεξήγηση των σταδίων δημιουργίας του, με τη 
χρήση των βοηθητικών προγραμμάτων Adobe After Effects και Adobe Illustrator.  

Η δομή της εργασίας χωρίζεται σε τέσσερα κεφάλαια. Στο πρώτο κεφάλαιο θα 
δούμε τον ορισμό του animation, την ιστορική αρχή του και πως εξελίχθηκε μέχρι και 
πριν την εμφάνιση των υπολογιστών. 

Στο δεύτερο κεφάλαιο θα αναφερθεί σύντομα η εφαρμογή του υπολογιστών 
στην εξέλιξη του animation και σε ποιους τομείς χρησιμοποιείται. 

Στο τρίτο κεφάλαιο θα αναφερθούν οι διάφορες τεχνικές animation. 
Στο τέταρτο κεφάλαιο θα παραθέσουμε τα βήματα παραγωγής ενός σύντομου 

βίντεο και θα αναλύσουμε τον τρόπο δημιουργίας κάποιων κύριων σκηνών με τα 
βοηθητικά προγράμματα After Effects CS6 και Adobe Illustrator CS6.  
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1 ΟΡΙΣΜΟΣ ANIMATION 

Ο όρος animation είναι λατινικής προέλευσης και βγαίνει από την λέξη 
«anima» που σημαίνει ψυχή ή και πνεύμα. Στα ελληνικά όμως δεν μπορεί να 
ερμηνευθεί με μια μόνο λέξη, γι’ αυτό και μεταφράζεται με διάφορες φράσεις όπως 
δίνω ζωή και κίνηση και ζωντανεύω (Βασιλειάδης, 2006, σ. 13).

 

O Βασιλειάδης (2006, σ. 13) αναφέρει ότι το animation είναι ένας ορισμός, 
(2006, σ. 13) που περικλείει από τις πιο παραδοσιακές τεχνικές που είναι το 
κινούμενο σχέδιο, μέχρι και τις πιο σύγχρονες που είναι το 3d computer animation. 
Λαμβάνοντας υπ’ όψιν όλες αυτές τις τεχνικές δίνει τη δική του απόδοση στον 
ορισμό αυτό για να δείξει ότι πρόκειται για κάτι συνθετικό προσπαθώντας να το 
διαχωρίσει από την πραγματικότητα: «Είναι η συνθετική παραγωγή της κίνησης δια 
μέσου  της συνεχόμενης χρήσης των ελαχίστων χρονικών στιγμών, που δίνει εκείνη την 
εκπληκτική αίσθησης της κίνησης στον θεατή, καθώς και άπειρες δυνατότητες 
χειρισμού και αλλοίωσης της πραγματικότητας» . (Βασιλειάδης, 2006, σ. 13) 

 Η Μούρη (2009, σ. 08) αναφέρει «το animation είναι η εμψύχωση σταθερών 
εικόνων, οι οποίες προβαλλόμενες στη σειρά δημιουργούν κινηματογραφική συνέχεια». 

Σε αντίθεση με τον κινηματογράφο, στον κινηματογράφο του animation δεν 
αναπαράγεται η πραγματικότητα, αλλά ο καλλιτέχνης μέσω της προσωπικής του 
επιλογής σχεδιάζει το δικό του σενάριο, στο οποίο γίνονται ηθοποιοί τα 
δημιουργήματα του, παίζοντας τους δικούς τους ρόλους, ζωντανεύοντας έτσι μια 
ιστορία καρέ καρέ για το κοινό για πρώτη φορά (Βασιλειάδης, 2006, σ. 45). 
Ουσιαστικά υπάρχει διαχωρισμός των μέσων. Στον κινηματογράφο τα γογονότα 
καταγράφονται σε χώρους με 24 καρέ το δευτερόλεπτο και αναπαράγονται με τον 
ίδιο ρυθμό. Στην περίπτωση του animation η κίνηση είναι συνθετική και αποδίδεται η 
φαντασία του καλλιτέχνη. Η λήψη γίνεται με λιγότερα καρέ ανάλογα την τεχνική. 
(Μούρη, 2013, σ. 70).  

 

1.1 ΙΣΤΟΡΙΚΗ ΑΡΧΗ ΤΟΥ ANIMATION 

Η αντίληψη της κίνησης οφείλεται στο φαινόμενο του μετεικάσματος. Tο μάτι 
και ο εγκέφαλος χρειάζονται ένα πολύ μικρό χρονικό διάστημα για να συγκρατήσουν 
μια εικόνα. Συγκεκριμένα μόνο 1/12 του δευτερολέπτου. Όταν για παράδειγμα το 
μάτι παρατηρήσει πολλές μεμονωμένες εικόνες στην σειρά πολύ γρήγορα δεν θα 
μπορέσει να τις δει σαν ξεχωριστές εικόνες αλλά σαν ένα ενιαίο αποτέλεσμα, 
δίνοντας έτσι την ψευδαίσθηση της κίνησης. Σήμερα τα καρέ στον κινηματογράφο 
διαχωρίζονται μεταξύ τους με μαύρα κενά τα οποία δεν γίνονται αισθητά εξαιτίας του 
φαινομένου αυτού. Ο κινηματογράφος προβάλλει 24 καρέ το δευτερόλεπτο. Με βάση 
αυτή την αρχή κατασκευάστηκαν και τα πρώτα ‘‘animation toys’’ (Μούρη, 2009, σ. 
09). Είναι ουσιαστικά οι πρώιμες συσκευές, οι πρώτες μηχανές που κατασκεύασε ο 
άνθρωπος για να επιτύχει κίνηση σε μια εικόνα (Μούρη, 2009, σ. 09). 

 



 

 

1.2 ΠΡΩΙΜΕΣ ΣΥΣΚΕΥΕΣ

 
Στο σημείο αυτό θα αναφερθούν οι πρώιμες συσκευές

προκειμένου να επιτευχθεί κίνηση σε μια εικόνα.
Το Θαυματοτρόπειο (Thaumatrope

οποίος έχει σε κάθε όψη του μπροστά και πίσω εικόνες. Στις δύο άκρες του αριστερά 
και δεξιά έχει δεμένα δύο κορδόνια. Πιάνοντας τις δύο άκρες του και περιστρέφοντας 
με μεγάλη ταχύτητα το δίσκο έχει σαν αποτέλεσμα οι 
μια ενιαία εικόνα. Από τα πιο χαρακτηριστικά παραδείγματα του θαυματοτροπείου 
είναι ο δίσκος που από τη μία πλευρά εμφανίζεται ένα πουλί και από την άλλη  ένα 
κλουβί. Το αποτέλεσμα αυτής της γρήγορης περιστροφής του δίσκου είνα
να φαίνεται μέσα στο κλουβί. Η εφεύρεση ανήκει στον 
(Μούρη, 2009, σ. 10). 

              

https://teacherswebresources.files.wordpress.com/2016/03/thaumatrope.jpg?w=358
 
Το Φενακιστισκόπιο (Phenakistiscope

οποίος διαθέτει στην άκρη του 
ανάμεσα στις σχισμές. Καθώς ο δίσκος περιστρέφεται
διαδοχικές εικόνες δίνουν την αίσθηση της κίνησης. Το ανακάλυψε ο 
Ferdinand Plateau το 1833 (Μούρη, 2009, σ. 10)

 
 

 
 
 
 

 
 
 
 

Θαυματοτρόπειο 

Εικόνα1
(Phenakistiscope)
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ΠΡΩΙΜΕΣ ΣΥΣΚΕΥΕΣ 

Στο σημείο αυτό θα αναφερθούν οι πρώιμες συσκευές που δημιουργήθηκαν 
προκειμένου να επιτευχθεί κίνηση σε μια εικόνα. 

Thaumatrope) είναι ένας δίσκος συνήθως κυκλικός
οποίος έχει σε κάθε όψη του μπροστά και πίσω εικόνες. Στις δύο άκρες του αριστερά 
και δεξιά έχει δεμένα δύο κορδόνια. Πιάνοντας τις δύο άκρες του και περιστρέφοντας 
με μεγάλη ταχύτητα το δίσκο έχει σαν αποτέλεσμα οι δύο εικόνες να φαίνονται σαν 
μια ενιαία εικόνα. Από τα πιο χαρακτηριστικά παραδείγματα του θαυματοτροπείου 
είναι ο δίσκος που από τη μία πλευρά εμφανίζεται ένα πουλί και από την άλλη  ένα 
κλουβί. Το αποτέλεσμα αυτής της γρήγορης περιστροφής του δίσκου είναι το πουλί 
να φαίνεται μέσα στο κλουβί. Η εφεύρεση ανήκει στον Dr. John Ayrton Paris

 
              Εικόνα1-1 Θαυματοτρόπειο 

ΠΗΓΗ: 
https://teacherswebresources.files.wordpress.com/2016/03/thaumatrope.jpg?w=358

Phenakistiscope  είναι ένας  δίσκος που περιστρέφεται
στην άκρη του σχισμές που ισαπέχουν. Οι εικόνες τοποθετούνται 

Καθώς ο δίσκος περιστρέφεται μπροστά από ένα καθρέφτη, οι 
διαδοχικές εικόνες δίνουν την αίσθηση της κίνησης. Το ανακάλυψε ο Joseph Antoine

(Μούρη, 2009, σ. 10). 

Θαυματοτρόπειο (Thaumatrope)

Εικόνα1-2 Φενακιστισκόπιο 
(Phenakistiscope) 

που δημιουργήθηκαν 

αι ένας δίσκος συνήθως κυκλικός, ο 
οποίος έχει σε κάθε όψη του μπροστά και πίσω εικόνες. Στις δύο άκρες του αριστερά 
και δεξιά έχει δεμένα δύο κορδόνια. Πιάνοντας τις δύο άκρες του και περιστρέφοντας 

δύο εικόνες να φαίνονται σαν 
μια ενιαία εικόνα. Από τα πιο χαρακτηριστικά παραδείγματα του θαυματοτροπείου 
είναι ο δίσκος που από τη μία πλευρά εμφανίζεται ένα πουλί και από την άλλη  ένα 

ι το πουλί 
Paris (1815) 

https://teacherswebresources.files.wordpress.com/2016/03/thaumatrope.jpg?w=358 

που περιστρέφεται ο 
εικόνες τοποθετούνται 

μπροστά από ένα καθρέφτη, οι 
Antoine 

https://teacherswebresources.files.wordpress.com/2016/03/thaumatrope.jpg?w=358
https://teacherswebresources.files.wordpress.com/2016/03/thaumatrope.jpg?w=358
https://teacherswebresources.files.wordpress.com/2016/03/thaumatrope.jpg?w=358


 

 

http://www.thisiscolossal
  
Το Στροβοσκόπιο (Stroboscope

κίνησης και  αποτελείται από  δύο δίσκους. Ο ένας περιέχει εικόνες και ο άλλος 
σχισμές. Με την ταυτόχρονη περι
εικόνα. Το επινόησε ο Stampfer

Εικόνα

https://www.google.gr/search?q=thaumatrope&source=l
0ahUKEwip7tynpN3UAhXFJMAKHcvcCd8Q_AUICigB&biw=1242&bih=602#tbm

=isch&q=Stroboscope++Stampfer++&imgrc=CTiQ7tksGX9YhM

Το  Ζωοτρόπιο ή ρόδα της ζωής (
εγκοπές. Μια χάρτινη ταινία με 
κυλίνδρου. Η ταινία αυτή αφαιρείται
αντικατάστασης της με μια άλλη
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ΠΗΓΗ: 
thisiscolossal.com/wp-content/uploads/2015/10/anim-1.jpg 

Stroboscope) είναι άλλη μια συσκευή προσομοίωσης 
κίνησης και  αποτελείται από  δύο δίσκους. Ο ένας περιέχει εικόνες και ο άλλος 

περιστροφή των δύο δίσκων δημιουργείται η κινούμενη 
Stampfer  το 1834  (Μούρη, 2009, σ. 10) . 

  
Εικόνα1-3 Στροβοσκόπιο 

ΠΗΓΗ: 
https://www.google.gr/search?q=thaumatrope&source=lnms&tbm=isch&sa=X&ved=
0ahUKEwip7tynpN3UAhXFJMAKHcvcCd8Q_AUICigB&biw=1242&bih=602#tbm

=isch&q=Stroboscope++Stampfer++&imgrc=CTiQ7tksGX9YhM: 
 

Το  Ζωοτρόπιο ή ρόδα της ζωής (Zoetrope) είναι ένας κύλινδρος με κάθετες 
ταινία με διαδοχικές εικόνες τοποθετείται εσωτερικά του 

κυλίνδρου. Η ταινία αυτή αφαιρείται εύκολα από τον κύλινδρο δίνοντας το περιθώριο 
αντικατάστασης της με μια άλλη (Μούρη, 2009, σ. 11). 

 

Εικόνα1-4 Ζωοτρόπιο 

 

είναι άλλη μια συσκευή προσομοίωσης 
κίνησης και  αποτελείται από  δύο δίσκους. Ο ένας περιέχει εικόνες και ο άλλος 

στροφή των δύο δίσκων δημιουργείται η κινούμενη 

nms&tbm=isch&sa=X&ved=
0ahUKEwip7tynpN3UAhXFJMAKHcvcCd8Q_AUICigB&biw=1242&bih=602#tbm

είναι ένας κύλινδρος με κάθετες 
είται εσωτερικά του 

εύκολα από τον κύλινδρο δίνοντας το περιθώριο 

https://www.google.gr/search?q=thaumatrope&source=l
https://www.google.gr/search?q=thaumatrope&source=l


 

 

https://www.google.gr/search?q=thaumatrope&source=lnms&tbm=isch
0ahUKEwip7tynpN3UAhXFJMAKHcvcCd8Q_AUICigB&biw=1242&bih=602#tbm

=isch&q=(Zoetrope)+&imgrc=yFeanpGvEBvSfM

Το Φαντοσκόπιο (Phantoscope
και της laterna magica. Θεωρείται ο πρώτος προβολέας.
στον Baron Franzvon Uchatius (1845)

Εικόνα

https://upload.wikimedia.org

 
Το Πραξινοσκόπιο (Praxinoscope

ζωοτρόπιου. Κατασκευάστηκε από τον Γάλλο 
από δυο κυλίνδρους. Αυτός που βρίσκεται στο εσωτερικό 

πρίσματα από καθρέπτες και εκτελεί περιστροφή
όσοι είναι αριθμητικά και οι καθρέπτες
καθρέπτες και όχι από τις εγκοπές του εξωτερ

Εικόνα1-
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ΠΗΓΗ: 
https://www.google.gr/search?q=thaumatrope&source=lnms&tbm=isch&sa=X&ved=
0ahUKEwip7tynpN3UAhXFJMAKHcvcCd8Q_AUICigB&biw=1242&bih=602#tbm

=isch&q=(Zoetrope)+&imgrc=yFeanpGvEBvSfM:  

antoscope) είναι ένας συνδυασμός του  phenakistiscope
Θεωρείται ο πρώτος προβολέας. Η εφεύρεση αυτή ανήκει 

(1845) (Μούρη, 2009, σ. 11). 

 
Εικόνα1-5 Φαντοσκόπιο (Phantoscope) 

ΠΗΓΗ: 
org/wikipedia/en/9/9d/Film_Jenkins_Phantascope

 

Praxinoscope) αποτελεί μια τελειοποιημένη έκδοση του 
Κατασκευάστηκε από τον Γάλλο Emile Reynaud το 1877. Αποτελείται 

που βρίσκεται στο εσωτερικό είναι επενδυμένος με 
και εκτελεί περιστροφή, ενώ ο εξωτερικός περιέχει εικόνες 

όσοι είναι αριθμητικά και οι καθρέπτες. Έτσι η κίνηση παρατηρείται μέσα από τους 
τες και όχι από τις εγκοπές του εξωτερικού κυλίνδρου (Μούρη, 2009, σ. 11)

 
-6 Πραξινοσκόπιο (Praxinoscope) 

&sa=X&ved=
0ahUKEwip7tynpN3UAhXFJMAKHcvcCd8Q_AUICigB&biw=1242&bih=602#tbm

phenakistiscope 
αυτή ανήκει 

Phantascope.jpg 

έκδοση του 
το 1877. Αποτελείται 

είναι επενδυμένος με 
ενώ ο εξωτερικός περιέχει εικόνες 

μέσα από τους 
(Μούρη, 2009, σ. 11).

https://www.google.gr/search?q=thaumatrope&source=lnms&tbm=isch
https://upload.wikimedia
https://www.google.gr/search?q=thaumatrope&source=lnms&tbm=isch
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ΠΗΓΗ: 
https://upload.wikimedia.org/wikipedia/commons/6/60/Lanature1882_praxinoscope_

projection_reynaud.png  
 

Ο Edward Muybridge παρήγαγε μια σειρά από συσκευές που του επέτρεπαν 
να αποθανατίσει ζώα και ανθρώπους σε κίνηση. Στη συνέχεια έφτιαξε την 
ζωοπραξινοσκόπιο μηχανή το 1878  (Zoopraxinoscope), η οποία πρόβαλε τις 
διαφάνειες (Μούρη, 2009, σ. 12). 

 
Εικόνα1-7 Ζωοπραξινοσκόπιο μηχανή (Zoopraxinoscope) 

ΠΗΓΗ: https://medyagurusu.files.wordpress.com/2014/04/horse-in-motion.jpg  
 

Ο κινεογράφος είναι αυτό που ονομάζουμε σήμερα “flipbook”. Ουσιαστικά 
είναι σχέδια ή εικόνες ελαφρά διαφοροποιημένα το ένα από το άλλο που έχουν δεθεί 
σε ένα βιβλίο. Για να επιτύχεις κίνηση πρέπει να ξεφυλίσεις πολύ γρήγορα το βίβλιο 
με τον αντίχειρα. Ανακαλύφθηκε το 1868. Το 1890 εφευρέθηκε το mutoscope από 
τον Herman Casler το οποίο είναι ένα flipbook, όπου αποτελείται από κάρτες οι 
οποίες είναι δεμένες με κορδόνια σε κυκλική διάταξη εκτελώντας μηχανική 
περιστροφή (Μούρη, 2009, σ. 13). 

 
Εικόνα1-8 Mutoscope 

ΠΗΓΗ: 
http://www.vitruvius.com.br/media/images/magazines/grid_9/4ee3_223-02.jpg 

https://upload.wikimedia.org/wikipedia/commons/6/60/Lanature1882_praxinoscope_
https://medyagurusu.files.wordpress.com/2014/04/horse-in-motion.jpg
http://www.vitruvius.com.br/media/images/magazines/grid_9/4ee3_223-02.jpg


 

 

  
O Emile Reynaud  δημιούργησε το οπτικό θέατρο 

πραξινοσκόπιο και “animated διαφάνειες
πρόβαλε σε οθόνη για μια οχταετία μέχρι το 1900
διάρκειας περίπου 10 λεπτών στο μουσείο 
films», όμως το ενδιαφέρον του κοινού χάθηκε με τ
(Μούρη, 2009, σ. 13) . 

 

https://upload.wikimedia.org/wikipedia/commons/thumb/d/d5/Theatreoptique.jpg/275

1.3 ΑΡΧΗ ΤΗΣ ΒΙΟΜΗΧΑΝΙΑΣ ΤΟΥ 

Μεγάλη καινοτομία για την εποχή εκείνη ήταν η εφεύρεση του φιλμ από 
celluloid υλικό το οποίο σε υψηλές θερμοκρασίες 
George Eastman το 1884. Αυτή την καινοτομία το 1895 οι Γάλλοι αδελφοί  
και Louis Lumiere κατασκευάζουν
μανιβέλα και χρησιμοποιούσε φιλμ από 
πλάι, συνδυάζοντας ταυτόχρονα  λήψη και προβολή .Ήταν ουσιαστικά το πρώτο 
βήμα στην εξέλιξη του κινηματογράφου.
καθώς το φιλμ ξετυλιγόταν από τα δόντια της μηχανής. 
φωτογραφίες το δευτερόλεπτο. 
των εργοστασίων Lumiere” ( La
 

1.4 ΑΠΟ ΤΗΝ ΕΠΟΧΗ ΤΩΝ ΠΡΩΤΟΠΟΡΩΝ ΜΕΧΡΙ ΤΟΝ ΝΤΙΣΝΕΫ

Το 1907 ένας τεχνικός της Βίταγκραφ 
κάμερα η οποία μπορούσε να κάνει λήψη εικόνα προς εικόνα χωριστά με το γύρισμα 
μανιβέλας “καταργώντας” τη μέχρι τότε λήψη εικόνας 16 ή 
2006, p. 17). Στις ΗΠΑ ο Alfred
Την τεχνική των ζωντανών λήψεων

28 

δημιούργησε το οπτικό θέατρο το 1889 συνδυάζοντας ένα 
διαφάνειες” (Μούρη, 2009, σ. 13) . Το οπτικό θέατρο 

μια οχταετία μέχρι το 1900 ζωντανές παντομίμες χρονικής 
διάρκειας περίπου 10 λεπτών στο μουσείο Greven. Θεωρείται η αρχή των «animation

», όμως το ενδιαφέρον του κοινού χάθηκε με τον ερχομό του κινηματογράφου

Εικόνα1-9 Οπτικό θέατρο 

ΠΗΓΗ: 
https://upload.wikimedia.org/wikipedia/commons/thumb/d/d5/Theatreoptique.jpg/275

px-Theatreoptique.jpg 
 

ΑΡΧΗ ΤΗΣ ΒΙΟΜΗΧΑΝΙΑΣ ΤΟΥ ANIMATION  

άλη καινοτομία για την εποχή εκείνη ήταν η εφεύρεση του φιλμ από 
υψηλές θερμοκρασίες έχει πλαστικές ιδιότητες από τον 
υτή την καινοτομία το 1895 οι Γάλλοι αδελφοί  Auguste

κατασκευάζουν την πρώτη κάμερα, η οποία κουρδιζόταν με 
και χρησιμοποιούσε φιλμ από celluloid υλικό με οδοντωτές τρύπες στο 

, συνδυάζοντας ταυτόχρονα  λήψη και προβολή .Ήταν ουσιαστικά το πρώτο 
βήμα στην εξέλιξη του κινηματογράφου. Η κίνηση μεταφερόταν από τρύπα σε τρύπα 
καθώς το φιλμ ξετυλιγόταν από τα δόντια της μηχανής. Η μηχανή πρόβαλλε 16 
φωτογραφίες το δευτερόλεπτο. Ένα πολύ γνωστό έργο των Lumiere είναι  “η έξοδος 

La Sortie des usines Lumiere) (Μούρη, 2009, σ. 14)

ΑΠΟ ΤΗΝ ΕΠΟΧΗ ΤΩΝ ΠΡΩΤΟΠΟΡΩΝ ΜΕΧΡΙ ΤΟΝ ΝΤΙΣΝΕΫ

Το 1907 ένας τεχνικός της Βίταγκραφ στη Νέας Υόρκης εφευρίσκει τη πρώτη 
κάμερα η οποία μπορούσε να κάνει λήψη εικόνα προς εικόνα χωριστά με το γύρισμα 

τη μέχρι τότε λήψη εικόνας 16 ή 24 καρέ (Βασιλειάδης, 
Alfred Clark και ο T.Edison ανακαλύπτουν το stop 

Την τεχνική των ζωντανών λήψεων χρησιμοποίησε ο Stuart Blacton στην ταινία 

συνδυάζοντας ένα 
Το οπτικό θέατρο 

παντομίμες χρονικής 
animation 

ν ερχομό του κινηματογράφου 

 

https://upload.wikimedia.org/wikipedia/commons/thumb/d/d5/Theatreoptique.jpg/275

άλη καινοτομία για την εποχή εκείνη ήταν η εφεύρεση του φιλμ από 
από τον 
Auguste 

την πρώτη κάμερα, η οποία κουρδιζόταν με 
υλικό με οδοντωτές τρύπες στο 

, συνδυάζοντας ταυτόχρονα  λήψη και προβολή .Ήταν ουσιαστικά το πρώτο 
Η κίνηση μεταφερόταν από τρύπα σε τρύπα 

Η μηχανή πρόβαλλε 16 
είναι  “η έξοδος 

(Μούρη, 2009, σ. 14). 

ΑΠΟ ΤΗΝ ΕΠΟΧΗ ΤΩΝ ΠΡΩΤΟΠΟΡΩΝ ΜΕΧΡΙ ΤΟΝ ΝΤΙΣΝΕΫ 

Νέας Υόρκης εφευρίσκει τη πρώτη 
κάμερα η οποία μπορούσε να κάνει λήψη εικόνα προς εικόνα χωριστά με το γύρισμα 

(Βασιλειάδης, 
 motion. 

στην ταινία 

https://upload.wikimedia.org/wikipedia/commons/thumb/d/d5/Theatreoptique.jpg/275
https://upload.wikimedia.org/wikipedia/commons/thumb/d/d5/Theatreoptique.jpg/275
https://upload.wikimedia.org/wikipedia/commons/thumb/d/d5/Theatreoptique.jpg/275
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κινουμένου σχεδίου “Humorous phases of funny faces” (1907) και  “Hunted Hotel” 
(1907) αλλά frame by frame. (Μούρη, 2009, p. 15) Η ταινία περιέχει εκτός από live-
action και stop-motion (Βασιλειάδης, 2006, p. 17). 

Ξεχωριστή θέση κατέχει στο κατάλογο των πρωτοπόρων ο Winsor Mc Cay 
για το έργο “Gertie the Dinosaur” (1909-1914). Πρόκειται για μια παράσταση μεταξύ 
δημιουργού και ενός θηλυκού δεινόσαυρου που ξεχωρίζει ιδιαίτερα διότι υπάρχει 
αλληλεπίδραση μεταξύ τους καθώς επίσης για την τελειότητα στις κινήσεις και την 
καθαρότητα στη σχεδίαση. Άλλα αξιόλογα προγενέστερα έργα του είναι το “Little 
Nemo” (1910) σε συνεργασία με τον Stuart Blacton και το “The story of mosquito” 
(1912). Το 1918 παρουσιάζει “The Sinking of the Lusitania”, σαν ντοκιμαντέρ. 
Δημιουργεί ακόμα μερικά φιλμ όπου το 1934 πεθαίνει. Ο Mc Cay ξεκίνησε την 
καριέρα του σαν καρτουνίστας σε εφημερίδες την Ν. Υόρκης αλλά και σαν 
σκηνογράφος του θεάτρου variete (Μούρη, 2009, pp. 15-16). 

Στην Ευρώπη πρωτοπόρος είναι ο Εμίλ Κολ για την ιδέα του να 
κινηματογραφήσει “καρέ -στοπ- καρέ” μια σειρά από σχέδια (Βασιλειάδης, 2006, σ. 
25). Πειραματίστηκε με πολλές τεχνικές και δούλευε μόνος. Θεωρείται ο πατέρας του 
ευρωπαϊκού animation (Μούρη, 2009, p. 17). 

Tην τεχνική των cut-out σιλουετών χρησιμοποιεί η Lotte Reiniger (1899-
1981) σε συνεργασία με τον Bartosh και τον Ruttman για να δημιουργήσουν το 
πρώτο μεγάλου μήκους Ευρωπαϊκό animation “Die Abenteuer des Prinzen Achmed” 
(Μούρη, 2009, p. 18). Η μέθοδος αυτή (Βασιλειάδης, 2006, σ. 54) είναι μια εξέλιξη 
του θεάτρου σκιών. Οι φιγούρες είναι λεπτοδουλεμένες, κινούνται με χάρη και η 
ταινία συνοδεύεται από κλασσική μουσική. 

Ο Alexander Alexeieff (1901-1982) είναι ένας ακόμα ευρωπαίος πρωτοπόρος 
ο οποίος δημιούργησε την τεχνική “οθόνη με καρφίτσες” Pinscreen (Μούρη, 2009, σ. 
23). Κατασκεύασε τη δική του μηχανή για να επιτύχει φωτοσκιάσεις και 
περιγράμματα. Ουσιαστικά είναι μια οθόνη 1,10μ. * 1,10 μ. η οποία περιλαμβάνει 
χιλιάδες καρφίτσες σε απόσταση ενός χιλιοστού η μια από την άλλη, καταφέρνοντας 
έτσι με την βοήθεια τεσσάρων προβολέων που βρίσκονται στις γωνίες του και τη 
μετακίνηση των καρφιτσών από μέσα έξω και το αντίθετο να δημιουργήσει σκιές. 
Στην συνέχεια θα φωτογραφήσει αυτό το αποτέλεσμα και έπειτα θα 
κινηματογραφήσει τις φωτογραφίες (Βασιλειάδης, 2006, σ. 39). 

Ο Λεν Λάι και στη συνέχεια ο Μακ Λάρεν δοκίμασαν μια πρωτοποριακή 
τεχνική για την εποχή αυτή στην ιστορία του animation την απευθείας σχεδίαση 
επάνω στο ίδιο το φιλμ (Βασιλειάδης, 2006, σσ. 53-54).  

Ενώ μέχρι τώρα χρησιμοποιούσαν την τεχνική του “cell animation” να 
δημιουργήσουν μια ταινία o Γάλλος δημιουργός Berthold Bartosch χρησιμοποιεί 
μαυρόασπρες φιγούρες και “cut-outs” πάνω σε ένα φωτισμένο φόντο (Βασιλειάδης, 
2006, σ. 67). 

To 1920  μπορούμε να θεωρήσουμε την αρχή της βιομηχανίας του κινούμενου 
σχεδίου.  Επιτυχία εκείνης της εποχής σημείωσαν ο Γάτος του Φίλιξ (Felix the Cat) 
του Pat Sullivan. Την επιτυχία αυτή ακολούθησε το κινούμενο Φλιπ ο βάτραχος (flip 
the frog) από τον Ub Iwerks ο οποίος σχεδίασε τον πρώτο ποντικό, τον πρώτο 
Mickey mouse, σχέδιο που στη συνέχεια θα τελειοποιηθεί και θα γνωρίσει επιτυχία 



 

 

από τον Walt Disney λόγω της επικείμενης συνεργασίας τους
47). 

Εικόνα

https://i.embed.ly/1/display/resize?key=1e6a1a1efdb011df84894040444cdc60&url=ht
tp%3A%2F%2F1.bp.blogspot.com%2F_lYTBHq7KR20%2FTOXV8q6jZwI%2FAA
AAAAAAPuQ%2FdTgfzdZ0prk%2Fs1600%2Famickey

    
 

Εικόνα

ΠΗΓΗ: http://www.tuttosuigatti.it/files/styles/large/public/images/bs/374/felix
cat.jpg?itok=sqg2A1ds

 
Άλλοι επιτυχημένοι της εποχής είναι οι αδελφοί 

έργο “ Έξω απ’ το μελανοδοχείο
φωτογραφία με το σχέδιο. Σχεδιάζεται ένα μοναδικό ντεκόρ για όλο το πλάνο, 
για κάθε καρέ ένα καινούριο σχέδιο. Διάσημο έργο τους επίσης είναι ο Ποπάι κα
συνέχεια ακολουθεί η Μπέτι Μπου
σσ. 47-48).  
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ης επικείμενης συνεργασίας τους (Βασιλειάδης, 2006, σ. 

 
Εικόνα1-10 Ub Iwerks Mickey- Mouse 

ΠΗΓΗ: 
https://i.embed.ly/1/display/resize?key=1e6a1a1efdb011df84894040444cdc60&url=ht
tp%3A%2F%2F1.bp.blogspot.com%2F_lYTBHq7KR20%2FTOXV8q6jZwI%2FAA
AAAAAAPuQ%2FdTgfzdZ0prk%2Fs1600%2Famickey-ub_iwerks.jpg&width=810

 
Εικόνα1-11 Felix the cat 

http://www.tuttosuigatti.it/files/styles/large/public/images/bs/374/felix
cat.jpg?itok=sqg2A1ds 

Άλλοι επιτυχημένοι της εποχής είναι οι αδελφοί Max και Dave Fleischer
ξω απ’ το μελανοδοχείο” και η “Κοκό ο Κλόουν”. Eδώ συνδυάζεται η 

φωτογραφία με το σχέδιο. Σχεδιάζεται ένα μοναδικό ντεκόρ για όλο το πλάνο, 
για κάθε καρέ ένα καινούριο σχέδιο. Διάσημο έργο τους επίσης είναι ο Ποπάι κα

Μπουπ (Betty Boop) (1935-1936) (Βασιλειάδης, 2006, 

(Βασιλειάδης, 2006, σ. 

https://i.embed.ly/1/display/resize?key=1e6a1a1efdb011df84894040444cdc60&url=ht
tp%3A%2F%2F1.bp.blogspot.com%2F_lYTBHq7KR20%2FTOXV8q6jZwI%2FAA

ub_iwerks.jpg&width=810  

http://www.tuttosuigatti.it/files/styles/large/public/images/bs/374/felix-

Fleischer με το 
δώ συνδυάζεται η 

φωτογραφία με το σχέδιο. Σχεδιάζεται ένα μοναδικό ντεκόρ για όλο το πλάνο, αντί 
για κάθε καρέ ένα καινούριο σχέδιο. Διάσημο έργο τους επίσης είναι ο Ποπάι και στη 

(Βασιλειάδης, 2006, 

https://i.embed.ly/1/display/resize?key=1e6a1a1efdb011df84894040444cdc60&url=ht
http://www.tuttosuigatti.it/files/styles/large/public/images/bs/374/felix
https://i.embed.ly/1/display/resize?key=1e6a1a1efdb011df84894040444cdc60&url=ht
http://www.tuttosuigatti.it/files/styles/large/public/images/bs/374/felix
https://i.embed.ly/1/display/resize?key=1e6a1a1efdb011df84894040444cdc60&url=ht
http://www.tuttosuigatti.it/files/styles/large/public/images/bs/374/felix
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ΠΗΓΗ 1-12: http://bettyboop.kingfeatures.net/files/2014/01/betty

ΠΗΓΗ 1-13: http://68.media.tumblr.com/tumblr_la8fmda5ps1qdtbwn.jpg

1.5 Η ΜΕΓΑΛΗ ΣΥΜΒΟΛΗ ΤΟΥ 
ΚΙΝΟΥΜΕΝΟΥ ΣΧΕΔΙΟΥ

Ενσωμάτωσε όλες τις 
φωτογραφία, στερεοφωνία, σινεμασκόπ
βελτίωσαν κατά πολύ το κινούμενο σχέδιο
του “story board” καθώς και για τα “
στην παραγωγή των ταινιών του. Ο 
γνώρισε πολλά χρόνια δόξας. 
σχεδίαζε στα έργα του και άνοιξε το 
νέων που ήθελαν να ασχοληθούν με το αντικείμενο
Το 1929 δημιουργεί το κινούμενο “
που ενσωματώνει ήχο. Το 1927 σχεδιάστηκε το πρώτο ποντίκι με το όνομα 
Μόρτιμερ. Το σχέδιο ανήκει στον 
Disney (Μούρη, 2009, σσ. 33-34)
στον Mickey Mouse και σταδιακά προστέθηκαν στην παρέα ο Ντόναλντ Ντάκ, η 
Μίνι, ο Πλούτο και ο Γκούφι. Η χρονολογία 1932
περίοδος του. Μερικά από τα έργα που αξίζει να αναφερθούν είναι “ Τα τρία μικρά 
γουρουνάκια” (Three Little Pigs
Trees) (1932) και ο “παλιός Μύ
Η Τρίτη ταινία του Disney είναι το “
σύστημα συγχρονισμού ήχου που έφτιαξε με τον βοηθό 
2009, σ. 33). Κορυφαίο αλλά και καινοτόμο είναι 
Νάνοι ” (Snow White and the Seven
μεγάλου μήκους ταινία κινούμενου σχεδίου. Γνωρίζοντας την 
συνεχίζει με γνωστά έργα όπως “Η Αλίκη στη χώρα των θαυμάτων” (1951), 
“Σταχτοπούτα” (1950). Από το 1939 προήλθε η παρακμή αφού όπως λέει και ο 
Βασιλειάδης (2006, p. 58) “αντικατέστησε την ελεύθερη φαντασ
με την στερεοτυπία και τον ακαδημαϊσμό
1964 λόγω του στούντιο που είχε δημιουργήσει, ασχολήθηκε σαν παραγωγός ταινιών 
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12 Betty Boop   Εικόνα1-13 Ποπάι 

http://bettyboop.kingfeatures.net/files/2014/01/betty-classic
pose.jpg 

http://68.media.tumblr.com/tumblr_la8fmda5ps1qdtbwn.jpg  

Η ΜΕΓΑΛΗ ΣΥΜΒΟΛΗ ΤΟΥ WALT DISNEY ΣΤΗΝ ΙΣΤΟΡΙΑ ΤΟΥ 
ΚΙΝΟΥΜΕΝΟΥ ΣΧΕΔΙΟΥ 

όλες τις νέες τεχνoτροπίες- ήχο, χρώμα, πολυεπίπεδη 
σινεμασκόπ- οι οποίες προχώρησαν σε νέο επίπεδο και 

λύ το κινούμενο σχέδιο. Είναι υπεύθυνος και για τη δημιουργία 
” καθώς και για τα “lay-out” αφού ήταν ο πρώτος που τα ενέταξε 

στην παραγωγή των ταινιών του. Ο Walt Disney επηρέασε πολύ την εποχή  του
 Έγινε γνωστός από τα ανθρωπόμορφα ζωάκια που 

σχεδίαζε στα έργα του και άνοιξε το studio Disney που αποτέλεσε κέντρο κατάρτισης 
να ασχοληθούν με το αντικείμενο (Βασιλειάδης, 2006, σσ. 55

Το 1929 δημιουργεί το κινούμενο “Skeletron Dance” που είναι το πρώτο καρτούν 
που ενσωματώνει ήχο. Το 1927 σχεδιάστηκε το πρώτο ποντίκι με το όνομα 
Μόρτιμερ. Το σχέδιο ανήκει στον Ub Iwerks ενώ ο χαρακτήρας ανήκει στον

34). Όσο περνούσαν τα χρόνια ο Μόρτιμερ εξελίχθηκε 
και σταδιακά προστέθηκαν στην παρέα ο Ντόναλντ Ντάκ, η 

, ο Πλούτο και ο Γκούφι. Η χρονολογία 1932-1937 θεωρείται η καλύτερη 
Μερικά από τα έργα που αξίζει να αναφερθούν είναι “ Τα τρία μικρά 

Pigs) (1933), “Λουλούδια και δέντρα” (Flowers
(1932) και ο “παλιός Μύλος” (the Old Mill)(1937) (Βασιλειάδης, 2006, σ. 61)

είναι το “Steamboat Willie” με μουσική και ήχο χάρης στο 
σύστημα συγχρονισμού ήχου που έφτιαξε με τον βοηθό animation Jackson (Μούρη, 

. Κορυφαίο αλλά και καινοτόμο είναι η ταινία “ H Χιονάτη και οι εφτά 
Seven Dwarfs) (1937) που είναι και η πρώτη γνωστή 

μεγάλου μήκους ταινία κινούμενου σχεδίου. Γνωρίζοντας την απόλυτη δόξα 
συνεχίζει με γνωστά έργα όπως “Η Αλίκη στη χώρα των θαυμάτων” (1951), 
“Σταχτοπούτα” (1950). Από το 1939 προήλθε η παρακμή αφού όπως λέει και ο 

αντικατέστησε την ελεύθερη φαντασία του γνήσιου καρτούν 
με την στερεοτυπία και τον ακαδημαϊσμό.” Λίγο πριν από τον θάνατο του, το 1951
1964 λόγω του στούντιο που είχε δημιουργήσει, ασχολήθηκε σαν παραγωγός ταινιών 

classic-

ΣΤΗΝ ΙΣΤΟΡΙΑ ΤΟΥ 

ήχο, χρώμα, πολυεπίπεδη 
οι οποίες προχώρησαν σε νέο επίπεδο και 

υπεύθυνος και για τη δημιουργία 
” αφού ήταν ο πρώτος που τα ενέταξε 

ύ την εποχή  του και 
Έγινε γνωστός από τα ανθρωπόμορφα ζωάκια που 

που αποτέλεσε κέντρο κατάρτισης 
(Βασιλειάδης, 2006, σσ. 55-56). 
” που είναι το πρώτο καρτούν 

που ενσωματώνει ήχο. Το 1927 σχεδιάστηκε το πρώτο ποντίκι με το όνομα 
ενώ ο χαρακτήρας ανήκει στον Walter 

. Όσο περνούσαν τα χρόνια ο Μόρτιμερ εξελίχθηκε 
και σταδιακά προστέθηκαν στην παρέα ο Ντόναλντ Ντάκ, η 

1937 θεωρείται η καλύτερη 
Μερικά από τα έργα που αξίζει να αναφερθούν είναι “ Τα τρία μικρά 

Flowers and 
(Βασιλειάδης, 2006, σ. 61). 

” με μουσική και ήχο χάρης στο 
(Μούρη, 

Χιονάτη και οι εφτά 
) (1937) που είναι και η πρώτη γνωστή 

απόλυτη δόξα 
συνεχίζει με γνωστά έργα όπως “Η Αλίκη στη χώρα των θαυμάτων” (1951), 
“Σταχτοπούτα” (1950). Από το 1939 προήλθε η παρακμή αφού όπως λέει και ο 

ία του γνήσιου καρτούν 
.” Λίγο πριν από τον θάνατο του, το 1951-

1964 λόγω του στούντιο που είχε δημιουργήσει, ασχολήθηκε σαν παραγωγός ταινιών 

http://bettyboop.kingfeatures.net/files/2014/01/betty
http://68.media.tumblr.com/tumblr_la8fmda5ps1qdtbwn.jpg
http://bettyboop.kingfeatures.net/files/2014/01/betty
http://68.media.tumblr.com/tumblr_la8fmda5ps1qdtbwn.jpg
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άλλων δημιουργών έχοντας τη γενική εποπτεία. Το 1966 ο Ντίσνεϊ πέθανε και ο 
αδερφός του αναλαμβάνει να διοικήσει την τεράστια αυτοκρατορία που άφησε πίσω 
του επεκτείνοντας τις δουλειές του (Βασιλειάδης, 2006, σσ. 60-66). Το 1995 η 
εταιρεία Disney σε συνεργασία με τη Pixar παρουσιάζουν το πρώτο μεγάλου μήκους 
3D animation Toy story (Μούρη, 2009, σ. 38). 

 

2 COMPUTER ANIMATION 

Το 1950 αναπτύχθηκε η τεχνολογία των γραφικών  σε  υπολογιστή η οποία 
όμως δεν προοριζόταν για καλλιτεχνική χρήση. Οι εφαρμογές που αναπτύχθηκαν, 
σχεδιάστηκαν αποκλειστικά για το στρατό και τις εφαρμοσμένες επιστήμες. 
Αφορούσαν κυρίως προσομοιώσεις πτήσεων για να εκπαιδεύσουν πιλότους χωρίς να 
χρειάζονται να πετάξουν σε αληθινό αεροπλάνο, συστήματα σχεδιασμού και 
παραγωγής για να επιτρέψουν στους ηλεκτρολόγους μηχανικούς να σχεδιάσουν και 
να τεστάρουν ηλεκτρικά κυκλώματα με εκατομμύρια εξαρτήματα και αξονικούς 
τομογράφους για να επιτρέψουν στους φυσικούς να ρίξουν μια ματιά στο ανθρώπινο 
σώμα χωρίς να χρειαστεί να το ανοίξουν (Kerlow, 2003, σ. 6). Ο πρώτος υπολογιστής  
κατασκευάστηκε στο MIT (Massasushetes Institute of Technology)  και ονομάστηκε 
Whirlwind με σκοπό την έρευνα αεροναυτικής (Στυλιάδης, 1999, σ. 09). Τη δεκαετία 
του 70-80 οι ηλεκτρονικοί υπολογιστές άρχισαν να γίνονται πιο πρακτικοί. Το 1990 η 
τιμή τους άρχισε να πέφτει και άρχισαν πολλοί να αγκαλιάζουν την τεχνολογία 
(Kerlow, 2003, σσ. 6-7).   

Αλλά ας δούμε τα γεγονότα που υπήρξαν σταθμός στην ιστορία των γραφικών 
σε υπολογιστή που οδήγησαν στην δημιουργία του δισδιάστατου και τρισδιάστατου 
animation.  

Τη δεκαετία του 60  αναπτύσσονται για πρώτη φορά τα διανυσματικά 
γραφικά (vectors). Χρησιμοποιείται για πρώτη φορά η τεχνολογία CRT από την IBM 
(IMB 2250 CAD console) το 1965 και από την Tektronix (Techtronic το 1968. 
Επιπλέον ιδρύεται η εταιρία Evans & Sutherland(1964) (Στυλιάδης, 1999, σ. 9). Το 
πρώτο διαδραστικό σύστημα αναπτύχθηκε από τον Ivan Sutherland στις αρχές του 
1960 και ονομάστηκε sketchpad από το πανεπιστήμιο MIT. Το σύστημα είχε 
δυνατότητες για την επίδειξη, μεταχείριση και την δημιουργία 2d και 3d εικονικών 
προσομοιώσεων μέσω μιας πένας με δέσμη φωτός (Kerlow, 2003, σ. 8). Ο χρήστης 
σχεδίαζε αρχικά τις κορυφές (end-points) ή και τις ενδιάμεσες  κορυφές (vertices) 
ενώ το σύστημα αναλάμβανε την αυτόματη υλοποίηση των πολυγώνων ή των 
γραμμών. Βεβαίως η τεχνολογία των CRT που στηριζόταν η παραγωγή γραφικών 
ήταν ακριβή ενώ και η μνήμη ενός ηλεκτρονικού υπολογιστή κόστιζε αρκετά 
(Στυλιάδης, 1999, σσ. 9-10).  

Το 70 έχουμε μείωση του κόστους της μνήμης Η/Υ γεγονός που συντέλεσε 
στην ανάπτυξη αλγόριθμων [Phong, 1973] και των ψηφιδωτών γραφικών (rasters) με 
τεχνικές παραγωγής ρεαλιστικών και έγχρωμων εικόνων σε διαδραστικά 
περιβάλλοντα με δυνατότητα υφής υλικών και διαχείρισης φωτός. ( gouraud’s 
shading, [1971] phong’s lighting, catmull’s textures, z-buffering) (Στυλιάδης, 1999, σ. 
10).  
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Ήταν μια σημαντική δεκαετία για την ανάπτυξη του τρισδιάστατου computer 
animation. Πολλές από τις βασικές τεχνικές φωτορεαλισμού που αναπτύχθηκαν τότε 
χρησιμοποιούνται ακόμα. Κατά τη διάρκεια αυτής της περιόδου το πανεπιστήμιο 
Utah υπήρξε πρωταρχική δύναμη στην έρευνα των 3d computer graphics. Σε 
σύγκριση με τη δεκαετία του 60 το 1970 υπήρχε μεγαλύτερη ανάπτυξη όσον αφορά 
τις τεχνικές για αναπαράσταση 3d σκηνικών αλλά και πάλι δεν υπάρχουν πολλοί 
καλλιτέχνες που να μπορούν εύκολα να ασχοληθούν ακόμα με αυτό το αντικείμενο 
(Kerlow, 2003, σ. 09). 

Προς τα τέλη του 1970 ένα από τα πιο γνωστά τριών διαστάσεων computer 
animation ήταν το Voyage 2 το οποίο οπτικοποιούσε τα ευρήματα του 
διαστημόπλοιου Voyage 2 και ήταν ένα παράδειγμα πρόωρης χρήσης των τεχνικών 
χαρτογράφησης εικόνας. Το 1974 το τεχνολογικό ινστιτούτο της Νέας Υόρκης 
έφτιαξε μια ερευνητική ομάδα με ένα αξιοσημείωτο κατάλογο από μηχανικούς και 
προγραμματιστές προκειμένου να αναπτύξει υλικό και λογισμικό γραφικών με 
απώτερο σκοπό να χρησιμοποιηθεί σε εμπορικές παραγωγές. To 1977 σχεδιάζονται  
από την Industrial Light & Magic (ILM) τα πρώτα οπτικά εφέ για τον George Lucas 
για την ταινία Star Wars. Αυτή η ταινία έφερε τα οπτικά εφέ στο προσκήνιο της 
κυρίαρχης κουλτούρας, αλλά η χρήση της τεχνολογίας των υπολογιστών αυτής της 
ταινίας περιοριζόταν κυρίως στα αυτοματοποιημένα συστήματα ελέγχου κίνησης που 
χρησιμοποιούνται για την κίνηση φωτογραφικών μηχανών και φυσικών 
μικροσκοπικών μοντέλων (Kerlow, 2003, σσ. 17-18).   

Το 80 από τα πιο σημαντικά γεγονότα είναι η δημιουργία παραδεκτών 
προτύπων ανάπτυξης γραφικής(graphics standars), η ανάπτυξη αλγορίθμου 
διαχείρισης ολικού φωτισμού ποιότητας (global illumination algorithms), και των 
graphics formats δηλαδή την εμφάνιση φορμών γραφικής/ανταλλαγής γραφικών 
πληροφοριών. Στην πρώτη κατηγορία έχουμε τα πρότυπα  GKS,X11  και PHIGS, ενώ 
αναπτύσσονται ο αλγόριθμος Ray tracing (αλγόριθμος για την τεχνική ιχνηλάτησης 
της φωτεινής ακτίνας)   και Radiosity (τεχνική διαχείρισης έμμεσου φωτισμού 
ποιότητας).Τέλος δημιουργήθηκαν και οι φόρμες ανταλλαγής dfx και bmp, tiff 
(raster) (Στυλιάδης, 1999, σ. 10). Το 1982 το φιλμ «Tron» της Disney ήταν η πρώτη 
ταινία μεγάλου μήκους η οποία περιείχε 20 λεπτά «computer animation» μαζί με 
«live action». Οι εταιρίες Industrial Light & Magic έχοντας την υπεροχή στο πεδίο 
των οπτικών εφέ συνεργάστηκαν με τον George Lucas στην ταινία “The Empire 
Strikes Back” και στο “Return of the Jedi”. Μια άλλη ταινία  “Indiana Jones and the 
Temple of Doom” το 1984 ήταν η πρώτη ταινία που είχε συνθετικές σκηνές (Kerlow, 
2003, σ. 19). Η ταινία “Young Sherlock Holmes” ήταν η πρώτη ταινία που είχε 
συνθετικό χαρακτήρα ένα ξεθωριασμένο τζάμι το οποίο γίνεται μέρος της δράσης. 
Στα δεύτερα μισά της δεκαετίας του 80 η εταιρεία Walt Disney Feature Animation 
άρχισε να ασχολείται με το 3d computer animation. Στη μεγάλου μήκους ταινία 
animation “The Black Cauldron”(1985) χρησιμοποιήθηκε σε ένα μικρό μέρος της 
ταινίας γραφικά υπολογιστή για να προσομοιώσουν μια  ιπτάμενη φωτεινή πηγή. Σε 
μια άλλη ταινία “the Great Mouse Detective” χρησιμοποιήθηκαν 3d computer 
τεχνικές για φτιάξουν και να κινηματογραφήσουν γρανάζια, τα οποία τα σχεδίασαν 
με τη βοήθεια σχεδιογράφου. Αυτό τους επέτρεψε να ενσωματωθούν στην 
παραγωγική διαδικασία της εποχής (Kerlow, 2003, σ. 21). Η ταινία “The Abyss” 
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(1989) (Kerlow, 2003, σ. 22) περιστρέφεται γύρω από ένα ψηφιακό τρισδιάστατο 
χαρακτήρα αρκετά ρεαλιστικό ώστε να μπλεχτεί με τη πραγματική δράση. Μια από 
τις πιο εντυπωσιακές στιγμές σε αυτή τη ταινία έιναι όταν το υδάτινο πλάσμα  
μιμείται τις εκφράσεις του προσώπου της ηθοποιού η οποία επίσης ακουμπά το 
εικονικό πλάσμα με το χέρι της (Kerlow, 2003, σ. 22).    

Το 90 το πρόβλημα που αντιμετώπιζαν τα πρότυπα GKS,X11 και PHIGS στην 
σύνθετη οπτικοποίηση και την κίνηση έρχονται να λύσουν τα νέα πρότυπα ανάπτυξης 
λογισμικού OpenGL και OpenInventor. Σε αυτή τη χρονική περίοδο εμφανίζονται τα 
λεγόμενα γραφικά τελικού χρήστη (High-end graphics), τα συστήματα γεωγραφικών 
πληροφοριών(SIS, GIS, LIS, AM/FM) (Στυλιάδης, 1999, σσ. 10-11). Η δεκαετία του 
1990  είναι σημαντική αφού τα γραφικά και κατ’επέκταση το computer animation στο 
πεδίο των παιχνιδιών αλλά και των οπτικών εφέ εξελίσσονται κατά πολύ. Ορόσημο 
αποτελεί η ταινία «Terminator II» το 1991 του James Cameron η οποία αποτέλεσε 
τεράστια εμπορική επιτυχία και συμπεριέλαβε την πρώτη πειστική προσομοίωση της 
ανθρώπινης φυσικής κίνησης. Ένα εξαιρετικό παράδειγμα computer animation έγινε 
στην ταινία του 1992 “Death Becomes Her” στην οποία έγινε ψηφιακό ρετουσάρισμα 
αφαιρώντας το κεφάλι ηθοποιού στο οποίο αργότερα προστέθηκε πάνω στο σώμα 
διαφορετική λήψη ενός πραγματικού κεφαλιού που μιλούσε. Στο Jurassic Park 1993 
του Steven Spielberg  χρησιμοποιήθηκε η τεχνική της «αντίστροφης κινηματικής». 
Άλλα παραδείγματα computer animation περιλαμβάνουν την ταινία “Primordial 
Dance” (1991) και “Liquid Selves” από τον Karl Sims (1992) στις οποίες έγινε χρήση 
της δημοφιλής τεχνικής γραφικών  σωματιδιακών συστημάτων (particle systems) 
(Kerlow, 2003, σ. 24). Το 1995 η ταινία “Toy story” από την Pixar ήταν η πρώτη 
ταινία που έγινε ολόκληρη αποκλειστικά με τη χρήση 3d τεχνικών. Ακολουθούν οι 
ταινίες που ήταν εξίσου εντυπωσιακές το 1999 από την Disney “Tarzan” και 
“Fantasia 2000”, “Toy Story 2” της Pixar, Warner Bros’ “Iron Giant” και 
Paramount’s “South Park” (Kerlow, 2003, σ. 26). Οι επιτυχίες συνεχίζονται (Kerlow, 
2003, σσ. 26-27) με ταινίες που περιέχουν οπτικά εφέ και 3d τεχνικές όπως το 
“Matrix” που κέρδισε το 1999 το βραβείο AMPASS  για τα καλύτερα οπτικά εφέ, με 
την ταινία “Stuart Little” για τον πρωτοποριακό συνδυασμό καρτούν και πραγματικής 
δράσης. Στην ταινία “Titanic” το 1997 δημιούργησαν με τη βοήθεια υπολογιστή νερό 
και ανιχνευτή κίνησης για να δημιουργήσουν ψηφιακά προσθήκες για το κατάστρωμα 
του καραβιού.  

“Η νέα χιλιετία (Στυλιάδης, 1999, σ. 11) αρχίζει με την πρόκληση για 
παράλληλη και κατανεμημένη διαχείριση των γραφικών πληροφοριών (collaborative 
Internet/Web graphics), με τις προσπάθειες για ολοκλήρωση των γραφικών με 
συστήματα με συστήματα χωρικής ανάλυσης και διαχείρισης τοπολογίας (CAD/GIS 
integration), καθώς και με την ανάγκη δημιουργίας νέων ουδέτερων προτύπων και 
φορμών ανταλλαγής γραφικών πληροφοριών που θα υποστηρίζουν εκτός των άλλων  
και δεδομένα πολυμέσων με χωρική διάσταση (multimedia GIS data)”. Ταινίες που 
αξίζει να αναφερθούν διότι αξιοποιούν τις δυνατότητες των υπολογιστών (Kerlow, 
2003, σ. 30) είναι η τριλογία “The Lord of Rings”, η ταινία Pearl Harbor στην οποία 
χρησιμοποιείται η απαραίτητη τεχνολογία για να αναπαραχθούν τα περισσότερα 
πλοία και αεροπλάνα καθώς γίνεται η χρήση σωματιδιακών συστημάτων για να 
προσομοιώσουν τον καπνό και τη φωτιά στις εκρήξεις. 
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Λόγω της ανάπτυξης στον ποιότητα και την ποσότητα της παραγωγής 
animation η Αμερικάνικη Ακαδημία Κινηματογραφικών Τεχνών και Επιστημών 
(AMPAS) πρόσθεσε μια νέα κατηγορία το 2001 για την βράβευση ετήσιας καλύτερης 
ταινίας animation μεγάλου μήκους. Η πρώτη ταινία που βραβεύτηκε ήταν η ταινία 
“Shrek” από την Dreamworks (Kerlow, 2003, σ. 31). Άλλες σημαντικές ταινίες 
(Kerlow, 2003, σ. 32) για την χρήση λογισμικού καταγραφής κίνησης (motion 
capture) από την Sony Imageworks  ήταν η ταινία “The Amazing Spiderman” και 
“Polar Express” της εταιρίας Warner Bros. Η νέα χιλιετία αποτελεί μεγάλη πρόκληση 
καθώς τα εφέ τελειοποιούνται, η ευκρίνεια «αυξάνεται» και οι ταινίες 
πολλαπλασιάζονται. Συνεπώς τα παραδείγματα είναι πολλά. Το μόνο σίγουρο είναι 
ότι με την πάροδο των χρόνων η τεχνολογία εξελίσσεται στο πεδίο αυτό 
προσφέροντας αξιοθαύμαστα αποτελέσματα και οι χρήστες απολαμβάνουν καλύτερη 
ποιότητα ταινιών με animation όσο και gaming. 

2.1 ΟΙ ΕΦΑΡΜΟΓΕΣ ΤΟΥ COMPUTER ANIMATION 

Η χρήση του computer animation  αναδεικνύει την χρησιμότητα του σε πολλά 
επίπεδα στην σύγχρονη εποχή. 

Αρχικά είναι αντιληπτό στη βιομηχανία και στο εμπόριο. Οι επιχειρήσεις 
χρησιμοποιούν πολύ συχνά 2d και 3d διαγράμματα είτε σταθερά είτε κινούμενα για 
να παρουσιάσουν σε μια σύσκεψη μια ιδέα ή να αναπαραστήσουν αριθμούς 
(Στυλιάδης, 1999, σ. 11). 

Ακόμα ένα σημαντικό πεδίο που βρίσκει εφαρμογή είναι το «κομμάτι» των 
προσομοιώσεων. Οι προσομοιωτές πτήσεων είναι χρήσιμες για τις αεροπορικές 
εταιρίες καθώς δίνουν την δυνατότητα στους πιλότους να κάνουν εξάσκηση στις 
πτήσεις σε αρκετά ρεαλιστικό περιβάλλον, εξοικονομώντας έτσι φυσικούς πόρους και 
χρήματα (Στυλιάδης, 1999, σ. 12). 

Επιπλέον βρίσκει εφαρμογή στον σχεδιασμό και την παραγωγή βιομηχανικών 
προϊόντων. Η τεχνολογία της «στερεάς προσομοίωσης» δίνει τη δυνατότητα 
σχεδίασης των τελικών χαρακτηριστικών των προϊόντων, από τα εξωτερικά 
χαρακτηριστικά μέχρι και την συμπεριφορά των υλικών όσον αφορά την αντοχή  και 
τη θερμοκρασία των υλικών. (Στυλιάδης, 1999, σ. 12) 

Οι αρχιτέκτονες χρησιμοποιούν computer animation για να απεικονίσουν και 
να σχεδιάσουν τις όψεις των κτιρίων και να μελετήσουν την συμπεριφορά κάθε 
κατασκευής κάτω από ορισμένες συνθήκες.  Είναι ιδανικό επίσης καθώς δίνει τη 
δυνατότητα προβολής των κτιρίων από οποιαδήποτε όψη και γωνία (Εθνικό 
Μετσόβιο Πολυτεχνείο, Τομέας Πληροφορικής, 2000). 

Επιπρόσθετα (Εθνικό Μετσόβιο Πολυτεχνείο, Τομέας Πληροφορικής, 2000) 
αποτελεί εργαλείο μάθησης για τα παιδιά που πηγαίνουν σχολείο. Η προβολή εικόνων 
και βίντεο τραβάει το ενδιαφέρον, καθιστά την μάθηση πιο ενδιαφέρουσα, ενώ 
μπορεί με διαγράμματα και κινούμενες φωτογραφίες να αποσαφηνίσει δύσκολες 
έννοιες στην σύλληψη τους. 

Στην παραγωγή film (Εθνικό Μετσόβιο Πολυτεχνείο, Τομέας Πληροφορικής, 
2000) είναι και από τους πιο διαδεδομένους τρόπους χρήσης του. Αυτό συμβαίνει 
διότι κάποιες σκηνές είναι αδύνατο να γυριστούν στην πραγματικότητα γιατί 
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πρόκειται για επιστημονική φαντασία και έτσι χρησιμοποιείται υπολογιστής. 
Χαρακτηριστικό παράδειγμα είναι η δημιουργία οπτικών εφέ με τη βοήθεια 
υπολογιστή. Άλλοι λόγοι επίσης είναι ότι ο υπολογιστής μειώνει το κόστος των 
δαπανών για το γύρισμα μιας σκηνής που θα χρειαζόταν μια παραγωγή να δαπανήσει 
για να δημιουργήσει τα απαραίτητα σκηνικά. Έτσι η ταινία γυρίζεται και αφού 
τελειώσει, εισάγεται στον υπολογιστή και επεξεργάζεται ψηφιακά στη συνέχεια. 

Στην τηλεόραση (Εθνικό Μετσόβιο Πολυτεχνείο, Τομέας Πληροφορικής, 
2000) υπάρχει στα προγράμματα μέχρι και στα δελτία ειδήσεων σπάζοντας την 
μονοτονία ενός προγράμματος και προκαλώντας το ενδιαφέρον με τα έντονα 
χρώματα και διάφορες κινήσεις.  

Χρησιμοποιείται για τη διαφήμιση ενός προϊόντος που απαιτεί τη κίνηση 
ψηφιακών γραφικών. Εντός ολίγων δευτερολέπτων ή και λεπτών πρέπει να πείσει 
τους καταναλωτές ότι το χρειάζονται και συνεπώς ότι πρέπει να το αγοράσουν. 
Επομένως είναι αναπόσπαστο κομμάτι του Marketing. (Στυλιάδης, 1999, σ. 13) 

Το κινούμενο σχέδιο θεωρείται ουσιαστικά video, και ξεγελάει το ανθρώπινο 
μάτι. Πιο παλιά τα κινούμενα σχέδια σχεδιάζονταν σε χαρτί και για μία και μόνο 
κίνηση ο σχεδιαστής υποχρεούνταν να σχεδιάσει ένα ένα τα καρέ, με ελάχιστη 
διαφορά μεταξύ τους ώστε να δημιουργηθεί τελικά η κίνηση. (Εθνικό Μετσόβιο 
Πολυτεχνείο, Τομέας Πληροφορικής, 2000) 

Συμβάλλει στη δημιουργία τέχνης αν και δεν θεωρείται αποδεκτή μορφή 
τέχνης. Παρέχει όμως εργαλεία για την δημιουργία υλικού που υπό άλλες συνθήκες  
θα ήταν δύσκολο να επιτευχθεί. (Εθνικό Μετσόβιο Πολυτεχνείο, Τομέας 
Πληροφορικής, 2000) 

 

3 ΟΙ ΔΙΑΦΟΡΕΣ ΤΕΧΝΙΚΕΣ TOY ANIMATION 

«Το κάθε καρέ στο animation δημιουργείται χωριστά. Το είδος της τεχνικής 
χαρακτηρίζεται από το μέσον που χρησιμοποιείται για να δημιουργηθούν τα καρέ.» 
(Μούρη, 2013, p. 69) 

3.1 ΚΙΝΟΥΜΕΝΟ ΣΧΕΔΙΟ 

Η πρώτη βασική τεχνική είναι το “κλασικό κινούμενο σχέδιο”. Αρχικά το 
σχέδιο ζωγραφίζεται πάνω σε ένα ριζόχαρτο. Αφού γίνει ένα πρόχειρο τεστ κίνησης, 
στη συνέχεια το σχέδιο περνάει σε ζελατίνες  με σινική μελάνι στην μπροστινή όψη. 
Όταν στεγνώσει το μελάνι  περνάνε από πάνω τα χρώματα στην πίσω μεριά της 
ζελατίνας με μεγάλη επιμέλεια και προσοχή τα σκούρα χρώματα να μην 
υπερκαλύψουν τα ανοιχτά για αυτό και ξεκινούν με τα σκούρα. Τέλος θα 
ζωγραφίσουν τα σκηνικά σε άλλο χαρτόνι  όπου πάνω τους θα τοποθετηθούν οι 
ζελατίνες. Στην συνέχεια πάνω σε ένα τραπέζι θα τοποθετηθεί το υλικό και θα 
φωτογραφηθεί κάτω από την φωτογραφική κάμερα που έχει στηθεί για αυτό το 
σκοπό. Πρώτα στο τραπέζι θα μπει το σκηνικό, μετά η ζελατίνη και μετά θα 
φωτογραφηθεί σαν ένα ενιαίο αποτέλεσμα. Επίσης τα σχέδια μπορούν να εισαχθούν 
στον υπολογιστή, με scanner ή σαν φωτογραφίες για να επεξεργαστούν και να 
μονταριστούν. Αυτή η διαδικασία θα γίνει για κάθε ξεχωριστό καρέ μέχρι να 
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ολοκληρωθεί η κίνηση. Σημείωση ότι παίζονται 24 καρέ το δευτερόλεπτο οπότε για 
γρήγορη ρυθμικά κίνηση χρειάζεται μια φωτογραφία ενώ για μια αργή δυο 
φωτογραφίες. Η κίνηση της κάμερας είναι ανά ένα καρέ (Βασιλειάδης, 2006, σ. 36). 

3.2 ΚΙΝΟΥΜΕΝΕΣ ΚΟΥΚΛΕΣ 

Μία άλλη τεχνική είναι οι “κινούμενες κούκλες”. Πρόκειται για τις γνωστές 
μαριονέτες οι οποίες έχουν στα άκρα τους νήματα για να μπορεί να τις μεταχειριστεί 
καλύτερα ο δημιουργός. Στην ουσία πρόκειται για τρισδιάστατο animation και έτσι η 
κάμερα μπορεί να αξιοποιήσει κάθε οπτική γωνία του σκηνικού και άλλες 
δυνατότητες όπως ζουμ-ιν, κοντινά, πανοραμικά πλάνα και οτιδήποτε άλλο 
χρησιμοποιείται στον «κανονικό κινηματογράφο». Ουσιαστικά η κίνηση γίνεται με τη 
μέθοδο «stop-motion».Οι κούκλες έχουν πολύ μεγάλο μέγεθος παραδείγματος χάριν 
4*8, ο σκελετός είναι από μέταλλο, και έχουν στις αρθρώσεις μπίλιες. Τα πρόσωπα 
τους δεν έχουν έκφραση για αυτό και μόνο το λόγο δημιουργούν και άλλα καλούπια 
με διαφορετικές εκφράσεις και αλλάζονται ανάλογα με το τροπή του σεναρίου. Τα 
δάχτυλα τους στο εσωτερικό έχουν σύρμα για να λυγίζουν ενώ τα χέρια τους είναι 
από πλαστικό. Το υλικό τους είναι είτε ξύλινο και σκαλίζεται, είτε πλαστικό και 
βάφεται από πάνω. Η Τσέχικη σχολή έχει καθιερώσει 10 καρέ για το κάθε πόδι εκτός 
και αν χρειαστεί κάποια πιο σύνθετη κίνηση τότε είναι περισσότερα. (Βασιλειάδης, 
2006, σ. 37). Πλέον η αλλαγή στην έκφραση γίνεται μέσω της επεξεργασίας με 
λογισμικό σε υπολογιστή (Μούρη, 2009, σ. 87).  
 

3.3 CUT-OUTS- ΝΤΕΚΟΥΠΑΡΙΣΜΕΝΑ ΧΑΡΤΙΑ 

Η τεχνική των «cut-outs» εκτελείται τεχνικά με τη μέθοδο των 
ντεκουπαρισμένων χαρτιών. Εδώ τα χρώματα αποδίδουν καλύτερα την τρίτη 
διάσταση. Τα σχέδια ζωγραφίζονται στο χαρτί. Οι φιγούρες έχουν αρθρώσεις που 
τους επιτρέπουν να κινούνται. Για να μπορούν τα σχέδια να μετακινούνται χωρίς να 
χάνεται η θέση τους κάτω από το background βάζουν ένα φύλλο πλαστικού μαγνήτη 
ενώ στο σχέδιο ένα λεπτό φύλλο μετάλλου. Τα μειονεκτήματα έγκειται στο γεγονός 
ότι δημιουργός βλέπει το τελικό αποτέλεσμα μετά την φωτογράφηση του σχεδίου και 
επίσης οι κινήσεις δεν έχουν τόση χάρη και ελαστικότητα (Βασιλειάδης, 2006, σ. 38). 

 

3.4 ΣΧΕΔΙΑΣΗ ΠΑΝΩ ΣΤΟ ΦΙΛΜ 

Επόμενη τεχνική είναι η απευθείας «ζωγραφική πάνω στο φιλμ». Στην ουσία ο 
δημιουργός ζωγραφίζει πάνω στο φιλμ κάθε εικόνα με πενάκια και παχύρευστα 
χρώματα. (Βασιλειάδης, 2006, σ. 38) Εδώ δεν χρησιμοποιείται κάμερα για την 
δημιουργία ταινίας. (Μούρη, 2009, σ. 86) 

3.5 ΖΩΓΡΑΦΙΚΗ ΚΑΤΩ ΑΠΟ ΤΗΝ ΚΑΜΕΡΑ 

Στην ζωγραφική κάτω από την κάμερα χρησιμοποιούν μια γυάλινη 
ημιδιαφανής επιφάνεια και εκεί απλώνουν χρωματιστή πλαστελίνη. Κάτω από την 
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επιφάνεια βάζουν μια φωτεινή πηγή για να προσδώσουν περισσότερο διαφάνεια στα 
χρώματα. Η διαδικασία ξεκινάει με ένα συγκεκριμένο κάδρο ζωγραφιστό. Στην 
συνέχεια μετακινείται, αναπροσαρμόζεται η εικόνα αυτή, ζωγραφίζεται ξανά μέρος 
αυτής, ή και ολόκληρη, αν έχει κίνηση όλο το κάδρο. Γενικά είναι μία από τις 
δύσκολες τεχνικές για να προσομοιώσεις κίνηση. (Βασιλειάδης, 2006, σ. 38) 

3.6 PIXILLATION 

Μια άλλη τεχνική ακούει στο όνομα Pixilation. Σε αυτήν λαμβάνει μέρος ο 
ηθοποιός  μπροστά από ένα φόντο και η κάμερα τραβάει καρέ-καρέ την κίνηση. Η 
κίνηση είναι λίγο απότομη και σπασμωδική. (Βασιλειάδης, 2006, σ. 39) 

3.7 ΟΘΟΝΗ ΜΕ ΚΑΡΦΙΤΣΕΣ 

Άλλη ενδιαφέρουσα τεχνική είναι η οθόνη με καρφίτσες. Η οθόνη έχει 
χιλιάδες καρφίτσες με πολλή μικρή απόσταση η μια από την άλλη περίπου 1 
χιλιοστό. Για να δημιουργηθούν φωτοσκιάσεις και περιγράμματα οι καρφίτσες 
προσαρμόζονται στην οθόνη πιο βαθειά ή και το αντίθετο. Έχει διαστάσεις 1,10*1,10 
μ. Διαθέτει στις τέσσερις γωνίες τέσσερις προβολείς.  Το αποτέλεσμα αυτό της σκιάς 
δημιουργεί στην ουσία ένα σχέδιο ή καλύτερα μια φιγούρα η οποία φωτογραφίζεται 
κάθε φορά για να κινηματογραφηθεί στην συνέχεια.. Όταν η καρφίτσα είναι μέσα 
δίνει μαύρο, έξω-έξω άσπρο και όταν είναι στο ενδιάμεσο γκρί. (Βασιλειάδης, 2006, 
σ. 39). 

3.8  ANIMATION ΑΝΤΙΚΕΙΜΕΝΩΝ-OBJECT ANIMATION 

Η τεχνική των τρισδιάστατων κινούμενων αντικειμένων τα οποία κινούνται από 
τον δημιουργό μπροστά στην κάμερα (Μούρη, 2009, σ. 82).  

3.9 ΚΙΝΟΥΜΕΝΟΙ ΤΙΤΛΟΙ ΤΑΙΝΙΩΝ 

Ενδιαφέρον παρουσιάζει και η τεχνική κινούμενοι τίτλοι ταινιών. 
Αναφέρονται στους αρχικούς τίτλους μιας ταινίας οι οποίοι έχουν σαν ρόλο να 
περιγράψουν με σύντομο τρόπο το θέμα, είτε με τη μορφή υπαινιγμών για  αυτό που 
θα ακολουθήσει, είτε με τη μορφή συμβόλων για να δώσουν το στίγμα. Πρέπει να 
είναι σύντομοι αλλά και να αποδίδουν το θέμα όσο καλύτερα γίνεται. (Βασιλειάδης, 
2006, p. 40) 

3.10 ΦΙΛΜ ΜΕ ΤΡΙΚ 

Σε επόμενο επίπεδο θα δούμε την τεχνική «φιλμ με τρικ» που γνωστότερος 
εκπρόσωπος της είναι ο Méliès. Σε αυτό το σημείο γίνεται αρχικά λήψη και αφού 
παρουσιαστεί το αποτέλεσμα γίνεται στην ουσία μοντάζ. Εδώ θα δούμε για πρώτη 
φορά τρικ, οπτικές απάτες δηλαδή. Αξιοποιούνται οι δυνατότητες της κάμερας 
αριστερά-δεξιά, πάνω-κάτω το αντικείμενο και Zoom-in και Zoom out. (Βασιλειάδης, 
2006, p. 40) 
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3.11 Η ΤΕΧΝΙΚΗ ΤΗΣ ΑΜΜΟΥ 

Η άμμος κινείται κάτω από την camera με κόντρα φως και η μετατόπιση της 
πραγματοποιεί την εμψύχωση. Το χρώμα δίνεται από την επιχρωματισμένη άμμο και 
ο τόνος από την ποσότητα της άμμου πάνω σε γυάλινη επιφάνεια. (Μούρη, 1960-
2000 Ελληνικο animation, 2013, σ. 76) 
 

3.12 ΤΕΧΝΙΚΕΣ ΠΟΥ ΣΥΝΔΕΟΥΝ ΤΟ ΡΕΑΛΙΣΜΟ ΜΕ ΤΟ ANIMATION 

3.12.1 ROTOSCOPE 
Ο σχεδιαστής παίρνει την κίνηση από την από το κινηματογραφημένο φιλμ, 

δεν την δημιουργεί από το μηδέν. Συνεπώς η κίνηση είναι ρεαλιστική. (Μούρη, 2013, 
σ. 77) 

3.12.2 MOTION CAPTURE  
Η κίνηση μεταβιβάζεται αυτόματα στον υπολογιστή από τα ηλεκτρόδια που 

φορά ο ηθοποιός. (Μούρη, 2013, σ. 77) 

3.12.3 TIME-LAPSE  
Χρησιμοποιείται η φωτογραφία. Σε μη ρεαλιστικούς χρόνους, γίνεται λήψη 

της πραγματικότητας καρέ- καρέ (Μούρη, 2013, σ. 77).  

3.13 COMPUTER ANIMATION- ANIMATION ΣΤΟΝ ΥΠΟΛΟΓΙΣΤΗ 

Εδώ ο δημιουργός έχει τον πλήρη έλεγχο της διαδικασίας και του τελικού 
αποτελέσματος συνδυάζοντας παραδοσιακές τεχνικές. Η τεχνική που χρησιμοποιείται 
για τις κινούμενες κούκλες είναι πολύ κοντά με την τρισδιάστατο animation στον 
έλεγχο κίνησης στο χώρο, στη διάπλαση των χαρακτήρων, την κίνηση της κάμερας, 
την επιλογή των φωτισμών και το στήσιμο του ντεκόρ. (Βασιλειάδης, 2006, σ. 40) 
Από το 1990 και μετά η επεξεργασία κινήσεων αλλά και σκηνικών γίνεται με την 
βοήθεια υπολογιστή. Το animation χωρίζεται σε δυο κατηγορίες το “2D computer 
animation ”  και το “3D computer animation”.Για το 2d ισχύει ότι και στις τεχνικές 
δημιουργίας του καρτούν.  Στο 3D οι φιγούρες έχουν σκελετό, όγκο (modeling) και 
ρούχα-δέρμα (mapping) (Μούρη, 2009, σ. 89) 

 

3.14 ΜΙΞΗ ANIMATION ΚΑΙ LIVE ACTION 

Για να πραγματοποιηθεί απαιτεί σχεδιασμό μέχρι την τελευταία λεπτομέρεια. 
Πρώτα κινηματογραφείται το live action και μετά και έχοντας ως γνώμονα αυτό 
σχεδιάζεται το animation. Στην περίπτωση που οι animation φιγούρες και οι ηθοποιοί 
κινούνται μαζί στην ίδια σκηνή γίνεται μίξη των δύο μέσων, πραγματικό περιβάλλον 
για τις φιγούρες, φανταστικό για τους ηθοποιούς. Με την μέθοδο του Rotoscoping 
κινηματογραφούσαν το live action καρέ-καρέ και με pegbar σε παλαιότερους 
καιρούς. Το live action προβαλλόταν από κάτω μέσου του καθρέφτη ενώ τα τελικά 
σχέδια κινηματογραφούνταν σε Rostrum camera στο γυαλί. Έτσι πραγματοποιούσαν 
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την ένωση. Τη σημερινή εποχή χρησιμοποιούν τη τεχνική blue screen για το live-
action και γίνεται επεξεργασία στον υπολογιστή. Επεξεργάζεται και το animation εκεί 
επίσης καρέ καρέ με τη χρήση αυτόματων μασκών και πολλών δυνατοτήτων για 
διόρθωση. (Μούρη, 2009, p. 90) 

 

4 ΒΗΜΑΤΑ ΠΑΡΑΓΩΓΗΣ 2D COMPUTER 
ANIMATION ME ΤΗ ΧΡΗΣΗ ΠΡΟΓΡΑΜΜΑΤΩΝ 
ADOBE ILLUSTRATOR CS6 ΚΑΙ ADOBE AFTER 
EFFECTS CS6 

Για την παρούσα εργασία φτιάχτηκε ένα σύντομο βίντεο animation με κύριο 
πρόγραμμα το Adobe Illustrator CS6 για τη δημιουργία γραφικών και  Adobe After 
Effects CS6 για την προσθήκη κίνησης. 

4.1 ΠΡΟΠΑΡΑΓΩΓΗ   

4.1.1 ΒΗΜΑ 1Ο –ΣΥΝΟΨΗ ΙΔΕΑΣ 
 
Είναι το πρώτο στάδιο που αναπτύχθηκε η ιδέα σύντομα για το σενάριο. Η 

ιδέα προήλθε μετά από παρακολούθηση σύντομων animation με πολύ γρήγορη 
δράση.  Έτσι βασική ιδέα αποτέλεσε η αντίθεση «πράκτορες-κατάσκοπος»,  έννοιες 
οι οποίες μπορούν να ανταποκριθούν σε βίντεο δράσης.  

 

4.1.2 ΒΗΜΑ 2Ο  ΣΕΝΑΡΙΟ – ΥΠΟΘΕΣΗ 
Η υπόθεση εξελίσσεται στο κτήριο μιας μυστικής υπηρεσίας η οποία έχει στην 

κατοχή της την μηχανή του χρόνου. Όποιος κρατήσει στα χέρια του την μηχανή αυτή 
θα αποκτήσει τεράστια δύναμη καθώς θα μπορέσει να ταξιδέψει στον χρόνο και γιατί 
όχι να αλλάξει την ιστορία. Την ηρεμία που βασιλεύει στην Υπηρεσία έρχεται να 
διαταράξει ένας κατάσκοπος αντίπαλης μυστικής υπηρεσίας, ο οποίος θα 
προσπαθήσει να την κλέψει. Έτσι στέκεται κρυμμένος στο απέναντι κτίριο και 
παρακολουθεί τις κινήσεις των πρακτόρων. Επειδή υπάρχει μεγάλη φύλαξη μπροστά 
από το δωμάτιο που βρίσκεται η μηχανή, αποφασίζει πως πρέπει να δράσει έτσι ώστε 
να τους διώξει από εκεί για να μείνει ανενόχλητος να πραγματοποιήσει τα δικά του 
σχέδια. Δοκιμάζει λοιπόν την μέθοδο του αντιπερισπασμού και στέλνει 
τηλεκατευθυνόμενη ηλεκτρονική συσκευή με τη μορφή εντόμου για να ενοχλήσει τον 
πράκτορα φρουρό. Ο πράκτορας αυτός πραγματικά ενοχλείται και προκειμένου να το 
αποφύγει σε μια κίνηση απελπισίας βγάζει το όπλο του και αρχίζει να πυροβολεί, 
γεγονός που προκαλεί αναστάτωση στην υπηρεσία και έτσι αναγκάζονται και 
υπόλοιποι που φυλούν την μηχανή να δουν τι συμβαίνει. Ο πράκτορας τρέχει από εδώ 
και από εκεί προκειμένου να γλυτώσει και οι υπόλοιποι σπεύδουν να βοηθήσουν. Το 
πεδίο λοιπόν μένει ελεύθερο και δίνει τη δυνατότητα στον κατάσκοπο να περάσει στο 
απέναντι κτίριο. Αφού κάνει κάποιες ενέργειες καταφέρνει να παρακάμψει κάποιους 
κωδικούς και να ανοίξει και την πόρτα του δωματίου αλλά και να «χακάρει» τη 
μηχανή. Όλα πάνε καλά αλλά τότε συνέβη το απρόοπτο και οι πράκτορες 
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αντιλαμβάνονται τι συμβαίνει όταν καταφέρνουν να χτυπήσουν ένα από το έντομο, το 
οποίο πέφτει κάτω και παίρνει φωτιά. Αμέσως σημαίνει συναγερμός και 
κατευθύνονται στο δωμάτιο που άφησαν αφύλακτο. Τότε αρχίζει η μάχη και οι 
πυροβολισμοί λαμβάνουν χώρα. Η πύλη έχει ήδη ανοίξει  και ενώ η μηχανή είναι 
έτοιμη να περάσει από μέσα της, σφαίρες τη χτυπούν και χαλάνε τη λειτουργία της. Ο 
κατάσκοπος είναι χωρίς ενισχύσεις και μην μπορώντας να υπερασπιστεί τον εαυτό 
του χάνει τη μάχη και πιάνεται από τους αντίπαλους πράκτορες. Τιμωρείται για αυτή 
την πράξη με φυλακή. 

4.1.3 ΒΗΜΑ 3 Ο – ΣΚΗΝΟΘΕΤΙΚΗ ΠΕΡΙΓΡΑΦΗ 
 
Εδώ η υπόθεση αναλύεται σκηνοθετκά με τη χρήση κειμένου και χωρίστηκε 

σε σκηνές. 
1η Σκηνή: εξωτερικός χώρος, βράδυ, κτίρια, κάμερα, άνεμος  

Είναι βράδυ. Η κάμερα δείχνει τα κτίρια της πόλης από μακριά. Πλησιάζει το μεσαίο 
κτίριο. Ακούγεται ελαφρύς άνεμος. 

2η Σκηνή: εσωτερικός χώρος, βράδυ, κατάσκοπος, απέναντι κτίριο, κιάλια, 
πράκτορας, μηχανή του χρόνου  

Ο κατάσκοπος βρίσκεται στο παράθυρο. Κοιτάζει μέσα από τα κιάλια στο 
απέναντι κτίριο και βλέπει τη μηχανή του χρόνου. Σαστίζει. Το πλάνο αλλάζει και 
δείχνει την μπροστινή όψη του κατάσκοπου. Το πλάνο πάλι αλλάζει. Κοιτάζει μέσα 
από τα κιάλια. Βλέπει τον πράκτορα. Ακούγεται ο ήχος των χεριών που κρατούν τα 
κιάλια, ένα σύντομο ηχητικό εφέ για την έκπληξη 
  3η Σκηνή: εσωτερικός χώρος, βράδυ, σατανικό γέλιο, υπολογιστής, συνομιλία, 
κατάσκοπος  
Ο κατάσκοπος πηγαίνει στο γραφείο και γελάει σατανικά. Κάθεται. Συνομιλεί με 
κάποιο συνεργάτη του μέσω υπολογιστή. Σηκώνεται. Πιάνει το τηλεχειριστήριο από 
το γραφείο. Στέλνει το έντομο. Ακούγονται ήχοι από υπολογιστή, βήματα, σατανικό 
γέλιο  

4η σκηνή: εσωτερικός χώρος, βράδυ, πράκτορας, υπηρεσία, έντομο, όπλο 
Ο πράκτορας βρίσκεται έξω από το δωμάτιο της μηχανής. Σφυρίζει. Μπαίνει το 
έντομο. Προσπαθεί  να ξεφύγει από το έντομο. Πυροβολεί με το όπλο του. Φεύγει 
από το δωμάτιο. Ακούγεται σφύριγμα, βουητό, πυροβολισμοί, βήματα. 

5η Σκηνή: εσωτερικός χώρος, βράδυ, πράκτορες 
Οι πράκτορες αναστατώνονται από το θόρυβο. Βγαίνουν έξω από το γραφείο και τον 
ψάχνουν. Ακούγονται ήχοι κινητών, βήματα. 

6η Σκηνή: εξωτερικός χώρος, βράδυ, κατάσκοπος, σκοινί, αέρας 
Ο κατάσκοπος είναι πάνω στο σκοινί και περνάει απέναντι στο κτίριο της υπηρεσίας. 
Ακούγεται ο άνεμος, το σκοινί τρίζει, η κάμερα τρέμει.        

7η Σκηνή: εσωτερικός χώρος, βράδυ, κατάσκοπος, δωμάτιο, μηχανή του 
χρόνου 
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Ο κατάσκοπος μπαίνει από το παράθυρο στο κτίριο, κάνει τούμπα. Ανοίγει τις πόρτες 
και μπαίνει με τούμπα στο δωμάτιο της μηχανής του χρόνου. Χακάρει τη μηχανή και 
τη βάζει σε λειτουργία.  Ακούγονται ήχοι ποδιών, βήματα, ήχοι κουμπιών.  

8η Σκηνή: εσωτερικός χώρος, βράδυ, πράκτορες, φωτιά, συναγερμός, δωμάτιο 
μηχανής  

Ο Πράκτορας κουνάει τα χέρια στον αέρα.Οι πράκτορες βοηθούν τον 
πράκτορα να αποφύγει το έντομο. Ο πράκτορας θα το χτυπήσει και θα πάρει φωτιά. 
Υπάρχει έκπληξη. Καταλαβαίνουν την παγίδα και τότε χτυπάει ο συναγερμός. 
Τρέχουν πάλι στο δωμάτιο. Ακούγεται έντονη αναπνοή, σπάσιμο γυαλιών, φωτιά, 
ηχητικό εφέ έκπληξης συναγερμός, τρέξιμο. 

9η Σκηνή: εσωτερικός χώρος, βράδυ, δωμάτιο, πράκτορες, πυροβολισμοί, 
κατάσκοπος, παράδοση 

Ο κατάσκοπος είναι έτοιμος να μπει στη χρονοπύλη. Οι πράκτορες βρίσκονται 
στο δωμάτιο της μηχανής και πυροβολούν. Πετυχαίνουν τη μηχανή. Χαλάει. 
Ανταλλάσσουν πυροβολισμούς με τον κατάσκοπο. Ο κατάσκοπος ξεμένει από 
σφαίρες και παραδίνεται.Πετάει κάτω το όπλο. Ακούγονται συναγερμός, 
πυροβολισμοί, πτώση όπλου, βήματα. 

10η Σκηνή: εσωτερικός χώρος, μέρα, κατάσκοπος, φυλακή 
Ο κατάσκοπος είναι φυλακή. Κλαίει. Ακούγεται κλάμα  

 

4.1.4 ΒΗΜΑ 4Ο – ΕΠΙΛΟΓΗ ΗΧΩΝ 
 
Με βάση την ανάγκη του σεναρίου και της κάθε σκηνής έγινε η επιλογή 

έτοιμων ηχητικών εφέ και η επιλογή του γενικού soundtrack που θα πλαισιώνει την 
ιστορία. Για τα ηχητικά εφέ επιλέχθηκε η βιβλιοθήκη ήχου της πλατφόρμας του 
προγράμματος του YouTube https://www.YouTube.com/audiolibrary/soundeffects. 
To τραγούδι που πλαισιώνει το βίντεο είναι από το site http://incompetech.com  και 
έχει τίτλο “Witch Hunt” με δημιουργό τον Kevin MacLeod. Κάποια ηχητικά εφέ 
κόπηκαν για να ταιριάζουν στην χρονική διάρκεια της κίνησης και κάποιες κινήσεις 
προσαρμόστηκαν στην χρονική διάρκεια των ηχητικών εφέ στο πρόγραμμα Adobe 
After Effects CS6.  
Παρακάτω δίνονται τα στοιχεία για το τραγούδι “Witch Hunt” 
"Witch Hunt" 
Kevin MacLeod (incompetech.com) 
Licensed under Creative Commons: By Attribution 3.0 
http://creativecommons.org/licenses/by/3.0/  
 

https://www.YouTube.com/audiolibrary/soundeffects
http://incompetech.com
http://creativecommons.org/licenses/by/3.0/
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4.2 ΠΑΡΑΓΩΓΗ – ΣΧΕΔΙΑΣΜΟΣ ΓΡΑΦΙΚΩΝ ΜΕ ΤΟ ΠΡΟΓΡΑΜΜΑ 
ADOBE ILLUSTRATOR  

4.2.1 ΓΝΩΡΙΜΙΑ ΜΕ ΤΟ ΠΕΡΙΒΑΛΛΟΝ ΤΟΥ ILLUSTRATOR 
 
Στο σημείο αυτό αρχίζει η παραγωγή γραφικών στο πρόγραμμα Adobe 

Illustrator CS6 . Εδώ δημιούργησα τις φιγούρες και τα σκηνικά για να μπορέσω να τα 
κινηματογραφήσω στην συνέχεια στο After Effects CS6. Ωστόσο ο σχεδιασμός 
κάποιων σκηνικών έγινε και μέσα After Effects καθώς δίνει τη δυνατότητα αυτή. Τα 
μέλη κάθε φιγούρας όπως θα φανεί αναλυτικά και στη συνέχεια σχεδιάστηκαν σε 
ξεχωριστά layers (επίπεδα) προκειμένου να συνδεθούν καταλλήλως στο After Effects 
με τη βοήθεια ενός ανεξάρτητου από το πρόγραμμα plugin το Duik. 

 
Αρχικά ας δούμε το περιβάλλον εργασίας του illustrator (Adobe Creative Team, 
2012, σ. 36) 

 
Εικόνα 4-1 Το περιβάλλον εργασίας του Adobe Illustrator CS6 

4.3 ΔΗΜΙΟΥΡΓΙΑ ΧΑΡΑΚΤΗΡΩΝ 

Αρχικά θα δημιουργήσω ένα νέο αρχείο ώστε να μπορέσω να φτιάξω τον 
πρώτο χαρακτήρα μου. Πηγαίνοντας επάνω στο Application bar επάνω αριστερά 
πατάω “File -->New”  και ανοίγει ένα παράθυρο με το όνομα “New document”. Στο 
πεδίο “Name” δίνω το όνομα “agent James”. Στις παραμέτρους στο αρχείο μου στο 
πεδίο Size ρυθμίζω τις παραμέτρους “Width” με 1000 mm και “Height” με 800 mm 
πατάω “ΟΚ”. 



 

 

Εικόνα 4

Πηγαίνοντας στο Application
layers. Έτσι στο παραθυράκι που εμφανίζεται επιλέγω με το ποντίκι το πρώτο 
και κάνω διπλό κλικ. Έτσι μου δίνεται η δυνατότητα να το ονομάσω. Δίνω το όνομα 
kefali. Πρώτα θα σχεδιαστεί το κεφάλι. Επειδή το κεφάλι έχει περίεργο σχήμα
καμπυλωτό θα επιλέξω το “pen
επιλέγω το pen tool (πενάκι). M
κάνω το πρώτο κλικ για να ξεκινήσω το σχήμα μου δημιουργώντας ένα σημείο
συνεχίζω το επόμενο κλικ για να φτιάξω το
πιο δεξιά και χωρίς να αφήσω το ποντίκι, το σέρνω μέχρι να έχω την επιθυμητή 
καμπύλη. Τότε μόνο αφήνω το κουμπί. Για να κλείσω το σχήμα μου  ξανακάνω κλικ  
στο αρχικό σημείο. Με το εργαλείο
επιλέγοντας τη καμπύλη ανάμεσα στα σημεία εμφανίζονται οι λαβές κατεύθυνσης. 
Αυτό το εργαλείο μου δίνει τη δυνατότητα να σύρω το τέλος της λαβής κατεύθυνσης 
μέχρι να είμαι ικανοποιημένη με τη καμπύλη που έχω φτιάξει.  Πατώντας διπλό κλικ 
αριστερά στα Tools panel στο 
και διαλέγω το χρώμα που θέλω να έχει το κεφάλι. Το τετραγωνάκι το μικρότερο στο 
χρώμα γεμίσματος αυτό που μόλις χρησιμοποίησα αφορά το περίγραμμα του 
σχήματος μου οπότε το ορίζω μαύρο. Μόλις σχηματίστηκε το κεφάλι οπότε ε
σχήμα είναι το πρόσωπο. (Adobe Creative Team, 2012, pp. 150
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Εικόνα 4-2 Άνοιγμα νέου αρχείου 

Application Bar στην επιλογή “Window” επιλέγω το πεδίο 
Έτσι στο παραθυράκι που εμφανίζεται επιλέγω με το ποντίκι το πρώτο 

και κάνω διπλό κλικ. Έτσι μου δίνεται η δυνατότητα να το ονομάσω. Δίνω το όνομα 
Πρώτα θα σχεδιαστεί το κεφάλι. Επειδή το κεφάλι έχει περίεργο σχήμα

pen tool” . Αριστερά στην εργαλειοθήκη Tools
Mε το πενάκι στη μέση του εγγράφου και λίγο ψηλά θα 

κάνω το πρώτο κλικ για να ξεκινήσω το σχήμα μου δημιουργώντας ένα σημείο
συνεχίζω το επόμενο κλικ για να φτιάξω το δεύτερο σημείο μου στην ίδια ευθεία λίγο 
πιο δεξιά και χωρίς να αφήσω το ποντίκι, το σέρνω μέχρι να έχω την επιθυμητή 
καμπύλη. Τότε μόνο αφήνω το κουμπί. Για να κλείσω το σχήμα μου  ξανακάνω κλικ  

Με το εργαλείο “Direct Selection Tool” (A)  στο πάνελ 
ανάμεσα στα σημεία εμφανίζονται οι λαβές κατεύθυνσης. 

Αυτό το εργαλείο μου δίνει τη δυνατότητα να σύρω το τέλος της λαβής κατεύθυνσης 
μέχρι να είμαι ικανοποιημένη με τη καμπύλη που έχω φτιάξει.  Πατώντας διπλό κλικ 

 χρώμα γεμίσματος  επιλέγω το λευκό τετράγωνο 
και διαλέγω το χρώμα που θέλω να έχει το κεφάλι. Το τετραγωνάκι το μικρότερο στο 

αυτό που μόλις χρησιμοποίησα αφορά το περίγραμμα του 
σχήματος μου οπότε το ορίζω μαύρο. Μόλις σχηματίστηκε το κεφάλι οπότε ε

(Adobe Creative Team, 2012, pp. 150-155) 

επιλέγω το πεδίο 
Έτσι στο παραθυράκι που εμφανίζεται επιλέγω με το ποντίκι το πρώτο layer 

και κάνω διπλό κλικ. Έτσι μου δίνεται η δυνατότητα να το ονομάσω. Δίνω το όνομα 
Πρώτα θα σχεδιαστεί το κεφάλι. Επειδή το κεφάλι έχει περίεργο σχήμα και 

Tools Panel 
ε το πενάκι στη μέση του εγγράφου και λίγο ψηλά θα 

κάνω το πρώτο κλικ για να ξεκινήσω το σχήμα μου δημιουργώντας ένα σημείο. Μετά 
δεύτερο σημείο μου στην ίδια ευθεία λίγο 

πιο δεξιά και χωρίς να αφήσω το ποντίκι, το σέρνω μέχρι να έχω την επιθυμητή 
καμπύλη. Τότε μόνο αφήνω το κουμπί. Για να κλείσω το σχήμα μου  ξανακάνω κλικ  

στο πάνελ Tools, 
ανάμεσα στα σημεία εμφανίζονται οι λαβές κατεύθυνσης. 

Αυτό το εργαλείο μου δίνει τη δυνατότητα να σύρω το τέλος της λαβής κατεύθυνσης 
μέχρι να είμαι ικανοποιημένη με τη καμπύλη που έχω φτιάξει.  Πατώντας διπλό κλικ 

επιλέγω το λευκό τετράγωνο 
και διαλέγω το χρώμα που θέλω να έχει το κεφάλι. Το τετραγωνάκι το μικρότερο στο 

αυτό που μόλις χρησιμοποίησα αφορά το περίγραμμα του 
σχήματος μου οπότε το ορίζω μαύρο. Μόλις σχηματίστηκε το κεφάλι οπότε επόμενο 



 

 

Εικόνα 4-3

 

Στο Layer Panel πατάω το εικονίδιο κάτω δεξιά 
Αυτό θα μου επιτρέψει στη συνέχεια να δημιουργήσω ένα καινούριο 
ένα νέο επίπεδο. Θέλουμε τα μέρη του σώματος να γίνουν σε ξεχωριστά 
επιτύχουμε ιεραρχική σύνδεση,
πρόγραμμα Adobe After Effects
ονομάζω το layer “proswpo”. Είναι πολύ βασικό το 
πάνω από το “kefali” στο Layer
στο ίδιο layer με το όνομα “
χρωματίστηκαν με τον τρόπο που υπέδειξα παραπάνω το καθένα ξεχωριστά. Τα 
μαλλιά, το μούσι και τα γυαλιά ξεφεύγουν από τα όρια του προσώπου. Ο λόγος θα 
εξηγηθεί αργότερα στο πρόγραμμα 

Εικόνα 4-4

Στη συνέχεια προστέθηκαν
“deksi frydi”,  “aristero xeri”, “
“swma” όπως φαίνεται στην επόμενη
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3 Σχεδιασμός κεφαλιού πράκτορα 

πατάω το εικονίδιο κάτω δεξιά “Create New Layer
Αυτό θα μου επιτρέψει στη συνέχεια να δημιουργήσω ένα καινούριο layer 
ένα νέο επίπεδο. Θέλουμε τα μέρη του σώματος να γίνουν σε ξεχωριστά layers
επιτύχουμε ιεραρχική σύνδεση, για λόγους που θα εξηγηθούν εκτενώς αργότερα στο

Effects. Με τον τρόπο που περιγράφθηκε παραπάνω 
Είναι πολύ βασικό το layer “proswpo” να βρίσκεται 

Layer Panel για να φαίνεται. Με το pen tool σχεδιάστηκε 
“proswpo” τα μαλλιά, το μούσι και τα γυαλιά και 

χρωματίστηκαν με τον τρόπο που υπέδειξα παραπάνω το καθένα ξεχωριστά. Τα 
μαλλιά, το μούσι και τα γυαλιά ξεφεύγουν από τα όρια του προσώπου. Ο λόγος θα 
εξηγηθεί αργότερα στο πρόγραμμα Adobe After Effects . 

 
4 Σχεδιασμός προσώπου πράκτορα 

προστέθηκαν σε νέα και ξεχωριστά layers το “aristero
”, “deksi xeri”, “aristero podi”, “deksi podi” 
επόμενη φωτογραφία. 

 

Layer” . 
 δηλαδή 

layers για να 
για λόγους που θα εξηγηθούν εκτενώς αργότερα στο 

Με τον τρόπο που περιγράφθηκε παραπάνω 
να βρίσκεται 
σχεδιάστηκε -

τα μαλλιά, το μούσι και τα γυαλιά και 
χρωματίστηκαν με τον τρόπο που υπέδειξα παραπάνω το καθένα ξεχωριστά. Τα 
μαλλιά, το μούσι και τα γυαλιά ξεφεύγουν από τα όρια του προσώπου. Ο λόγος θα 

aristero frydi”, 
” και το 



 

 

Εικόνα 4-

 
Μέσα στο ίδιο έγγραφο υπάρχουν και οι εκφράσεις του στόματος τα οποία 

είναι και αυτά  ξεχωριστά layers
στόματος, ιδιαίτερα  για τις διάφορες εκφράσεις που μπορεί να χρειαστούν κατ
διάρκεια της εξέλιξης του σεναρίου.(εικόνα 

Εικόνα 4-6 Οι εκφράσεις του στόματος για την γυναίκα πράκτορα
άνδρα πράκτορα 

 
 Οι άλλες δύο αντρικές φιγούρες του έργου στηρίζονται ακριβώς στο ίδιο 

σκελετό  με την μόνη διαφορά ότι έχουν 
στο χρώμα των ρούχων ή των μαλλιών και των γυαλιών. Όλοι οι χαρακτήρες 
σχεδιάστηκαν με την ίδια λογική. Παρακάτω βλέπουμε τους υπόλοιπους χαρακτήρες 
έτοιμους. 
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-5 Ο χαρακτήρας ολοκληρωμένος 

Μέσα στο ίδιο έγγραφο υπάρχουν και οι εκφράσεις του στόματος τα οποία 
layers σχεδιασμένα αποκλειστικά για το συγχρονισμό του 

στόματος, ιδιαίτερα  για τις διάφορες εκφράσεις που μπορεί να χρειαστούν κατ
διάρκεια της εξέλιξης του σεναρίου.(εικόνα 4-6) 

Οι εκφράσεις του στόματος για την γυναίκα πράκτορα και για τον 

Οι άλλες δύο αντρικές φιγούρες του έργου στηρίζονται ακριβώς στο ίδιο 
σκελετό  με την μόνη διαφορά ότι έχουν μικρές διαφορές στο χρώμα του δέρματος, 
στο χρώμα των ρούχων ή των μαλλιών και των γυαλιών. Όλοι οι χαρακτήρες 
σχεδιάστηκαν με την ίδια λογική. Παρακάτω βλέπουμε τους υπόλοιπους χαρακτήρες 

Μέσα στο ίδιο έγγραφο υπάρχουν και οι εκφράσεις του στόματος τα οποία 
για το συγχρονισμό του 

στόματος, ιδιαίτερα  για τις διάφορες εκφράσεις που μπορεί να χρειαστούν κατά τη 

 
και για τον 

Οι άλλες δύο αντρικές φιγούρες του έργου στηρίζονται ακριβώς στο ίδιο 
μικρές διαφορές στο χρώμα του δέρματος, 

στο χρώμα των ρούχων ή των μαλλιών και των γυαλιών. Όλοι οι χαρακτήρες 
σχεδιάστηκαν με την ίδια λογική. Παρακάτω βλέπουμε τους υπόλοιπους χαρακτήρες 
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Εικόνα 4-7 Γυναίκα πράκτορας                       Εικόνα 4-8 Άνδρας πράκτορας  

 
 

 
Εικόνα 4-9 Illustrator Εικονογράφηση παλάμης 

Οι παλάμες των χαρακτήρων είναι ξεχωριστά project, τα οποία θα συνδεθούν 
και αυτά αργότερα στο After Effects. Η παλάμη, καθώς και όλα τα δάχτυλα 
δημιουργήθηκαν σε ξεχωριστά layers για να συνδεθούν με συγκεκριμένο τρόπο 
αργότερα. Όλα σχεδιάστηκαν με το pen tool (P) και χρωματίστηκαν στη συνέχεια. 

4.4 ΔΗΜΙΟΥΡΓΊΑ ΣΚΗΝΙΚΩΝ ΣΤΟ ILLUSTRATOR 

Τα περισσότερα γραφικά δημιουργήθηκαν στο illustrator κάποια όμως από 
αυτά σχεδιάστηκαν και στο After Effects αφού διαθέτει αυτή την ικανότητα. 

Για τις πόρτες της υπηρεσίας και το σχεδιασμό τους χρησιμοποίησα αρχικά 
Rectangle Tool (M)  (Adobe Creative Team, 2012, σ. 89). Σχηματίστηκαν 
διαδοχικά τα τετράγωνα και στη συνέχεια χρωματίστηκαν το καθένα ξεχωριστά. Η 
πρόσοψη αυτή έγινε σε ένα layer. Τα σήματα της υπηρεσίας ήταν έτοιμες εικόνες τις 
οποίες επεξεργάστηκα χρωματικά. Από το Application Bar επιλέγω “Object-> Image 
Trace-> Make and Expand” .Τώρα μπορώ να επιλέξω όποιο σχήμα θέλω της εικόνας 
και να το χρωματίσω. (Adobe Creative Team, 2012, σ. 21) 

 



 

 

Εικόνα 4-10, Πόρτες υπηρεσίας, 

 
Άλλα σκηνικά που σχεδιάστηκαν στο 

Εικόνα 4-12 Δωμάτιο, 

Εικόνα 4-14 Χειροκίνητος μηχανισμός, 

4.5 Η ΚΙΝΗΣΗ ΚΑΙ Η ΔΗΜΙΟΥΡΓΙΑ ΟΠΤΙΚΩΝ ΕΦΕ ΜΕ ΤΟ 
ΠΡΟΓΡΑΜΜΑ ADOBE

 

4.5.1  ΕΙΣΑΓΩΓΗ ΣΤΟ ΠΡΟΓΡΑΜΜΑ 
     
Είναι ο χώρος που τα γραφικά

επιπρόσθετο plugin Duik το οποί
ξεχωριστών μελών-τμημάτων (
γεγονός που εξασφάλισε καλύτερα αποτελέσματα στην κίνηση. Επιπλέον 
συγχρονίστηκε η μουσική με την κίνηση. Κάθε σκηνή φτιάχτηκε σε δικό της 
composition και στο τέλος έγινε βίντεο
έγινε το μοντάζ δηλαδή όλα τα βίντεο 
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Πόρτες υπηρεσίας,   4-11 Εσωτερικό κτίριο-καρέκλα οθόνη

Άλλα σκηνικά που σχεδιάστηκαν στο illustrator με παρόμοιο τρόπο. 

Δωμάτιο, Εικόνα 4-13 Απέναντι κτίριο, 

Χειροκίνητος μηχανισμός, Εικόνα 4-15 Όπλο 

 

Η ΚΙΝΗΣΗ ΚΑΙ Η ΔΗΜΙΟΥΡΓΙΑ ΟΠΤΙΚΩΝ ΕΦΕ ΜΕ ΤΟ 
ADOBE AFTER EFFECTS CS6  

ΕΙΣΑΓΩΓΗ ΣΤΟ ΠΡΟΓΡΑΜΜΑ ADOBE AFTER EFFECTS CS6 

τα γραφικά πήραν κίνηση. Βασικό ρόλο έπαιξε 
οποίο όπως θα δούμε πραγματοποίησε τη σύνδεση των 

τμημάτων (layers) του χαρακτήρα προσθέτοντας «κόκκαλα»
γεγονός που εξασφάλισε καλύτερα αποτελέσματα στην κίνηση. Επιπλέον 
συγχρονίστηκε η μουσική με την κίνηση. Κάθε σκηνή φτιάχτηκε σε δικό της 

ς έγινε βίντεο. Τέλος όταν ολοκληρώθηκαν όλες οι σκηνές,
βίντεο μαζί ενώθηκαν σε ένα. 

 
καρέκλα οθόνη 

 

 

Η ΚΙΝΗΣΗ ΚΑΙ Η ΔΗΜΙΟΥΡΓΙΑ ΟΠΤΙΚΩΝ ΕΦΕ ΜΕ ΤΟ 

ασικό ρόλο έπαιξε το 
τη σύνδεση των 

«κόκκαλα», 
γεγονός που εξασφάλισε καλύτερα αποτελέσματα στην κίνηση. Επιπλέον 
συγχρονίστηκε η μουσική με την κίνηση. Κάθε σκηνή φτιάχτηκε σε δικό της 

. Τέλος όταν ολοκληρώθηκαν όλες οι σκηνές, 



 

 

Εικόνα 4-16 Περιβάλλον εργασίας 

 
Α. Application Window, B. Tools Panel, C. Project Panel, D. Composition 

Panel, E. Timeline Panel, F. Time Graph, G. Grouped Panels(Info 
Preview Panels, I. Effects & presets

4.6 ΕΙΣΑΓΩΓΗ ΓΡΑΦΙΚΩΝ

Αφού ανοίξω την εφαρμογή, το πρώτο βήμα που θα κάνω είναι να πάω στο 
Application Window και να αποθηκεύσω το 
Εκεί θα δώσω στο πεδίο “Όνομα αρχείου
αποθηκεύσω το project στον ίδιο φάκελο με τα αποθηκευμένα αρχεία του 
Πηγαίνοντας Project Panel κάνον
>File εμφανίζεται το παράθυρο για την εισαγωγή υλικού στο 
επιφάνεια εργασίας επιλέγω τον φάκελο με το όνομα 
το όνομα images, το αρχείο illustrator
“Άνοιγμα” (Adobe Creative Team

Εικόνα 4-17

Μόλις φορτώσει τα αρχεία μέσα στο 
παράθυρο με τα πεδία “Import 
πρώτο πεδίο επιλέγω Composition
Αυτή η επιλογή ουσιαστικά θα φέρει τα αρχεία μέσα στο Α
πραγματικό τους μέγεθος χωρίς να μας απασχολήσει το φόντο

49 

 
Περιβάλλον εργασίας Adobe After Effects CS6 

Application Window, B. Tools Panel, C. Project Panel, D. Composition 
Panel, E. Timeline Panel, F. Time Graph, G. Grouped Panels(Info and Audio), H. 
Preview Panels, I. Effects & presets (Adobe Creative Team, 2012, σ. 11) 

ΓΡΑΦΙΚΩΝ ΑΠΟ ILLUSTRATOR ΣΤΟ AFTER EFFECTS

Αφού ανοίξω την εφαρμογή, το πρώτο βήμα που θα κάνω είναι να πάω στο 
και να αποθηκεύσω το project πηγαίνοντας “File->Save

Όνομα αρχείου” το όνομα: Η μηχανή του χρόνου και θα 
στον ίδιο φάκελο με τα αποθηκευμένα αρχεία του illustrator
κάνοντας διπλό κλικ με το ποντίκι ή αλλιώς File->

εμφανίζεται το παράθυρο για την εισαγωγή υλικού στο After Effect. Από την 
επιφάνεια εργασίας επιλέγω τον φάκελο με το όνομα ptyxiakh και από τον φάκελο με 

illustrator με το όνομα agent και πατάω την επιλογή 
Team, 2012, p. 12) (εικόνα 4-17). 

7 Εισαγωγή υλικού στο After Effect 

Μόλις φορτώσει τα αρχεία μέσα στο After Effects θα εμφανιστεί ένα νέο 
 kind” και “Footage Dimensions” (εικόνα 4-1

Composition και στο δεύτερο “Layer size” και πατάω 
Αυτή η επιλογή ουσιαστικά θα φέρει τα αρχεία μέσα στο Αfter Effects
πραγματικό τους μέγεθος χωρίς να μας απασχολήσει το φόντο. 

Application Window, B. Tools Panel, C. Project Panel, D. Composition 
and Audio), H. 

EFFECTS  

Αφού ανοίξω την εφαρμογή, το πρώτο βήμα που θα κάνω είναι να πάω στο 
Save as”. 

το όνομα: Η μηχανή του χρόνου και θα 
illustrator.  
>Import-
Από την 

και από τον φάκελο με 
και πατάω την επιλογή 

 

θα εμφανιστεί ένα νέο 
18). Στο 

και πατάω “ΟΚ”. 
Effects στο 
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Εικόνα 4-18 Retain Layer Size 

Τώρα παρατηρούμε ότι τα αρχεία φορτώθηκαν μέσα στο After Effect στο 
Project Panel.(εικόνα 4-19) Το πρώτο εικονίδιο που βλέπουμε ουσιαστικά είναι ένα 
composition που έχει δημιουργηθεί για το συγκεκριμένο Project του illustrator και 
ακριβώς από κάτω είναι ο φάκελος με όλα τα αρχεία που έχουν μεταφερθεί από το 
illustrator μέσα στο After Effect. 

  
Εικόνα 4-19 Tα αρχεία μέσα στο After Effect 

Layers  είναι τα συστατικά που χρησιμοποιείς για να φτιάξεις ένα 
composition. Οτιδήποτε αντικείμενο προσθέσεις σε ένα composition όπως μια 
σταθερή εικόνα, ένα αρχείο κινούμενης εικόνας, ένα αρχείο ήχου, μια φωτεινή πηγή, 
μια κάμερα ή ακόμα ένα άλλο composition, γίνεται ένα νέο layer. Χωρίς layers ένα 
composition αποτελείται μόνο από ένα άδειο frame (Adobe Creative Team, 2012, p. 
17). 

Σε ένα composition  δημιουργoύνται όλες οι κινήσεις, τα επίπεδα-layer και τα 
εφέ σε μια σύνθεση. Ένα composition μπορεί να περιλαμβάνει ένα η περισσότερα 
layer, τα οποία διατάσσονται στο Composition Panel και στο Timeline Panel. 
Οτιδήποτε προσθέσεις σε ένα composition γίνεται ένα νέο layer. Ένα composition 
μπορεί να έχει πολλά layers και μπορείς επίσης να συμπεριλάβεις ένα composition 
σαν layer μέσα σε ένα άλλο composition, αυτό αποκαλείται «nesting» (Adobe 
Creative Team, 2012, pp. 13-14)  

Το επόμενο βήμα είναι να δημιουργήσουμε ένα Composition. Στο Project 

Panel εμφανίζονται ένα εικονίδιο   και ένας φάκελος με τα αρχεία του illustrator. 
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Κάνοντας διπλό κλικ στο πρώτο πεδίο με το εικονίδιο , είτε ανοίγοντας τον 
φάκελο και σέρνοντας τα αρχεία του κάτω στο timeline panel, ανοίγει ένα 
composition με το όνομα agent το οποίο θα περιλαμβάνει όλα τα αρχεία του project 
agent.ai (εικόνα 4-20) Με “Ctrl+K” ανοίγω το παράθυρο διαλόγου για ρύθμιση των 
διαστάσεων, της ανάλυσης και χρονικής διάρκειας του composition. Αφού τα 
ρυθμίσω επιλέγω ΟΚ. 

 
Εικόνα 4-20 Εμφάνιση του composition agent στο Timeline Panel. 

Κάθε layer έχει κάποιες ιδιότητες μέσα στο Αfter Effects. Έτσι πατώντας το 
βελάκι να ανοίξει προς τα κάτω στο layer “kefali” εμφανίζεται η επιλογή Τransform. 
Πατώντας πάλι το βελάκι προς τα κάτω εμφανίζονται τα πεδία Anchor Point το οποίο 
ορίζει σε ποιό σημείο του layer το πρόγραμμα θα περιστρέψει ένα αντικείμενο κατά 
τον άξονα x’ και y’, το Position που αναφέρεται στην φυσική θέση του αντικειμένου 
μέσα στο project (x’ και y’ άξονας), το Scale που αναφέρεται στο μέγεθος του και 
πόσο αντίστοιχα μπορείς να το μεγεθύνεις ή να το μικρύνεις, το Rotation ορίζει πόσες 
μοίρες θα περιστραφεί ένα αντικείμενο και τέλος το opacity που δείχνει πόσο τοις 
εκατό είναι ορατό ένα αντικείμενο. Τα layers είναι δύο διαστάσεων για αυτό και οι 
ιδιότητες τροποποιούνται ως προς τον άξονα x’ και y’. 

Εμείς αρχικά θέλουμε να ορίσουμε το σημείο περιστροφής Anchor Point σε 
κάθε layer σύμφωνα με τη φυσική ιδιότητα του σώματος. Έτσι για το layer “kefali” 
θα ορίσουμε το Anchor Point (Adobe Creative Team, 2012, p. 125) να βρίσκεται στο 
κάτω μέρος του κεφαλιού, με τη χρήση του εργαλείου Pan Behind (Anchor point) 

Tool (Y)  (εικόνα 4-21). 
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Εικόνα 4-21 Οριοθέτηση Anchor Point στο layer κεφάλι 

Στη συνέχεια θα ορίσουμε το Anchor Point για κάθε ένα layer ξεχωριστά. 
Έτσι για το δεξί χέρι θα το ορίσουμε πάνω στον ώμο, το ίδιο και για το αριστερό ενώ 
για το αριστερό πόδι και το δεξί αντίστοιχα πάνω στους γλουτούς, ενώ το σώμα θα 
μείνει στο κέντρο.(εικόνα 4-22) Αν για παράδειγμα τώρα που ρυθμίσαμε το Anchor 
Point δοκιμάζαμε να περιστρέψουμε το αριστερό χέρι, το χέρι θα περιστρεφόταν 
γύρω από τον ώμο όπως είναι η φυσική κίνηση του χεριού. 

 
Εικόνα 4-22 Ρύθμιση Anchor Point για όλα τα μέλη του σώματος 

 

Επιλέγοντας το Selection Tool  (V) επιλέγω το layer “aristero xeri”.Σειρά 

έχει η εφαρμογή του επόμενου εργαλείου Puppet Pin Tool   (ctrl+P). (Adobe 
Creative Team, 2012, pp. 212-213) Έχοντας επιλεγμένο το εργαλείο εφαρμόζω πάνω 
στο χέρι ένα κλικ στον ώμο, ένα στον αγκώνα και ένα στο κάτω μέρος του χεριού 
όπως θα φανεί στην επόμενη εικόνα (LeeDanielsART, 2014).(Εικόνα 4-23) 
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Εικόνα 4-23 Eφαρμογή Puppet Pin Tool στο layer "aristero xeri". 

 
Στο layer “aristero xeri” στο Timeline Panel αν πατήσεις το βελάκι προς τα 

κάτω (ή αν πατήσεις τη συντόμευση στο πληκτρολόγιο “Ε”, θα οδηγήσει κατευθείαν 
στην επιλογή Puppet) θα δημιουργήσει το πεδίο Effects. Πατώντας την καρτέλα να 
ανοίξει προς τα κάτω θα υπάρχει το πεδίο Puppet και πατώντας το βέλος να ανοίξει, 
θα ανοίξουν και άλλα επιπρόσθετα πεδία από τα οποία θα επιλέξω το Mesh1. Μόλις 
το ανοίξω θα πατήσω την επιλογή Deform και τότε θα εμφανιστούν τα “pins” που 
προσθέσαμε στο αριστερό χέρι του χαρακτήρα μου με την ονομασία “Puppet pin 1”, 
“Puppet pin” 2, “Puppet pin” 3. Πατώντας “Enter” στο πληκτρολόγιο ή δεξί κλικ και 
Rename τα μετονομάζω σε “shoulder L” (1), “elbow L” (2) και “hand L” (3). Με τα 
ίδια ακριβώς βήματα κάνω το ίδιο για το layer “deski xeri” μόνο που προσέχω στην 
ονομασία των pins να μην δώσω την ίδια ονομασία οπότε για το πρώτο Pin δίνω 

όνομα “shoulder R” (1), “elbow R” (2), “hand R” (3). Για το Layer “aristero podi” θα 
εφαρμόσω από πάνω προς τα κάτω πάλι τρία Pins και ονομάζω το πάνω “hips L” (1), 
“knee L” (2) και “foot L” (3) και αντίστοιχα για το layer “deskι podi” το πρώτο “hips 
R” (1), “knee R” (2) , “foot R” (3). Για το layer “swma” θα βάλουμε τέσσερα pins ένα 
σε κάθε ώμο - στα σημεία “shoulder L” και “shoulder R”, “hips L” και “hips R”-  ένα 
στους γοφούς αφήνοντας την ονομασία όπως είναι (LeeDanielsART, 2014).(Εικόνα 

4-24) 
 

 
Εικόνα 4-24 Εφαρμογή Puppet Pin Tool σε όλο το σώμα 
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4.7 ΔΙΑΔΙΚΑΣΙΑ ΣΧΕΔΙΑΣΗΣ ΣΚΕΛΕΤΟΥ ΚΙΝΗΣΗΣ ΤΟΥ ΧΑΡΑΚΤΗΡΑ 
ΜΕ ΤΗ ΒΟΗΘΕΙΑ ΤΟΥ PLUGIN DUIK. 

To Duik είναι ένα plugin το οποίο δεν είναι ενσωματωμένο μέσα στο After 
Effects αλλά μπορείς να το βρεις και να το κατεβάσεις δωρεάν στο πρόγραμμα από 
τη σελίδα https://rainboxprod.coop/en/tools/duik/ και σε βοηθάει να στήσεις τον 
“σκελετό” ενός χαρακτήρα. Σκοπό έχει να κάνει ευκολότερη τη μεταχείριση ενός 
χαρακτήρα. 

Αφού έχω περάσει τα pins  σε όλα τα μέλη του σώματος ήρθε η ώρα να 
περάσω «κόκκαλα» πάνω σε αυτά. Έχοντας επιλεγμένο το “aristero xeri” στο Duik 
Panel επιλέγουμε το πεδίο “Bones” και αυτό αυτόματα εφαρμόζει τα «κόκκαλα» 
πάνω στα “Puppet Pins”. Tα «κόκκαλα» που δημιουργήθηκαν στην θέση των Puppet 
Pins πήραν αυτόματα και την ονομασία τους (LeeDanielsART, 2014). ("B_shoulder 
L", "Below L", "Behind L") (Εικόνα 4-25) 

 
Εικόνα 4-25 Εφαρμογή Bones από Duik Panel 

Επόμενο βήμα είναι να χρησιμοποιήσουμε το εργαλείο το Pick Whip Tool 
 για να δημιουργήσουμε γονική σχέση (parent) ανάμεσα στο B_hand L με το 

B_elbow L και το B_elbow L με το B_shoulder L όπως φαίνεται και στην επόμενη 
φωτογραφία (Εικόνα 4-26) (LeeDanielsART, 2014). 

 
Εικόνα 4-26 Bones parenting σε "aristero xeri" 

Στη συνέχεια έχοντας επιλεγμένο το layer “B_hand L” στο παράθυρο του 
Duik Panel  επιλέγω το πεδίο “Controllers”. Στο παράθυρο που θα εμφανιστεί 
επιλέγω “Create” (εικόνα 4-27) (LeeDanielsART, 2014). 

https://rainboxprod.coop/en/tools/duik/
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Εικόνα 4-27 δημιουργία controller για "aristero xeri" layer 

 
Στο “B_hand L” επομένως δημιουργήθηκε ένα σημείο χειραγώγησης controller το 
“C_B hand L” (εικόνα 4.28). Τέλος πιάνοντας με τη συγκεκριμένη σειρά με το 
κουμπί Ctrl και κλικ, τα “B_hand L”, “B_elbow L”, “B_shoulder L” και τέλευταίο το 
“C_B hand L” στο Duik Panel επιλέγουμε το κουμπί “ΙΚ”. Στο παράθυρο που 
εμφανίζεται στη συνέχεια επιλέγουμε “2-layer ΙΚ Goal” (εικόνα 4-29) και πατάμε 
“Create”. Τέλος έχοντας επιλεγμένο το νέο μας controller “C_B hand L” επιλέγουμε 
στο Duik Panel το κουμπί “Zero pos(0)”. Αυτή η επιλογή θα μηδενίσει την θέση του 
controller στην θέση x’ και y’ γεγονός που διευκολύνει να βρίσκεις την αρχική στάση 
του χαρακτήρα όταν χρειαστεί μετά από πολλές κινήσεις (LeeDanielsART, 2014). 

Εικόνα 4-28 Controller C_B hand L               4-29  Δημιουργία αλυσίδας 2 IK               
 

Επαναλαμβάνω ακριβώς την ίδια διαδικασία για το άλλο χέρι και τα πόδια. 
Εκεί που βρίσκεται το πάνελ Project δίπλα ακριβώς εμφανίζεται το πάνελ Effect 
controls. Σε κάθε controller βγαίνουν οι εξής επιλογές (εικόνα 4-30). Το πεδίο 
Clockwise ρυθμίζει τον προσανατολισμό των χεριών μου (αριστερά ή δεξιά) οπότε με 
κλειδιά το ρυθμίζω κάθε ποιά χρονική στιγμή θέλω να είναι από την αριστερή μεριά 
και πότε από την δεξιά (LeeDanielsART, 2014). 



 

56 
 

 
Εικόνα 4-30 Effects controls C_B hand L 

Επιλέγοντας τώρα το layer “swma” πηγαίνω όπως και στις άλλες περιπτώσεις 
στο Duik Panel και πατάω την επιλογή “Bones”. Αφού δημιουργηθούν τα bones 
πατάω στο application window “Layer-> New -> Null Object” το οποίο εμφανίζεται 
στο Timeline Panel με το όνομα Null1. Με το πλήκτρο Enter το μετονομάζω σε 
“Hips”. Αυτό το layer μέχρι στιγμής δεν κάνει κάτι. Πατώντας Ctrl+ D ή Edit-> 
Duplicate κάνω ένα αντίγραφο το οποίο το ονομάζω “Shoulder”. Επιλέγω το 
“B_Puppet Pin 1” και “B_Puppet Pin 2” με ctrl και κλικ και με το pick whip tool τα 
συνδέω με το κενό layer “Shoulder”. Ομοίως επιλέγω “B_Puppet Pin 3” και 
“B_Puppet Pin 4” me ctrl και κλικ και με το pick whip tool τα συνδέω με το κενό 
layer “Hips” (LeeDanielsART, 2014). (Εικόνα 4-31, 4-32) 

 
Εικόνα 4-31 Shoulder Controllers NULL

 

Εικόνα 4-32 Hips Controllers NULL 
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Τέλος θα κλειδώσουμε τα “B_Puppet Pin 1”, “B_Puppet Pin 2”, “B_Puppet 
Pin 3” και “B_Puppet Pin 4” με το λουκέτο έτσι και αλλιώς δεν θα μας χρειαστούν 
πλέον και με control θα επιλέξω να ενώσω  με το “Pick Whip Tool” στο layer 
“Shoulder” τα bones “B_shoulder L” , “B_shoulder R” και το layer “kefali” ενώ στο 
layer “Hips” θα συνδέσω τα “hips L” και “hips R”. Επίσης το layer proswpo θα το 
συνδέσω με το “Pick Whip Tool” με το layer “kefali” (LeeDanielsART, 
2014).(εικόνα 4-33, 4-34) 

 
Εικόνα 4-33 hips controller parent hips L, hips R - 4-34 shoulder controller- parent 
shoulder L, shoulder R 

Έχοντας επιλεγμένα τα hips και shoulder στο Duisk Panel πατάω Zero pos(0). Με 
όλες αυτές τις ενέργειες καταφέραμε να στήσουμε τον χαρακτήρα. Αν τώρα για 
παράδειγμα κάνω περιστροφή το layer “Hips” 16 μοίρες και μειώσω το position, το 
κάτω μέρος του σώματος και τα πόδια του χαρακτήρα θα επηρεαστούν αυτόματα. 
(Εικόνα 4-35). Από εδώ και στο εξής χειρίζομαι τη θέση των μερών του σώματος με 
controllers περνώντας κλειδιά στα ανάλογα πεδία (position, rotation κ.τ.λ.). Πλέον 
διαλέγοντας το σημείο από όπου θέλουμε να ξεκινήσει η κίνηση, υπολογίζονται οι 
κινήσεις των συνδέσμων των μερών σε σχέση με το σημείο που έχουμε πάρει ως 
αναφορά. (Εθνικό Μετσόβιο Πολυτεχνείο, Τομέας Πληροφορικής, 2000) 

 
Εικόνα 4-35  hips rotation and position 

 

4.8 LIP SYNC – ΣΥΓΧΡΟΝΙΣΜΟΣ ΧΕΙΛΙΩΝ 

Μέσα στο project agent.ai υπάρχουν τα σχέδια του στόματος που 
σχεδιάστηκαν στο illustrator. Σκοπός είναι όταν το απαιτεί το σενάριο να μπορούν να 
χρησιμοποιηθούν με όσο το δυνατόν μεγάλη ευκολία. Από το composition agent 
λοιπόν στο timeline panel επιλέγω με control και κλικ όλα τα layer που απεικονίζουν 
τις εκφράσεις του στόματος και πατάω δεξί κλικ-> Pre-compose. Στο παράθυρο που 
ανοίγει ονομάζω το νέο composition “stoma” και επιλέγω “move all attributes into 
the new composition” και πατάω ΟΚ.(εικόνα 4-36). Τώρα δημιουργήθηκε ένα νέο 
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composition  με το όνομα “stoma” που μέσα περιέχει όλα τα layers με τις εκφράσεις 
του στόματος. Με το Pick Whip Tool συνδέουμε το στόμα με το proswpo, έτσι ώστε 
αν περιστρέψουμε ή μετακινήσουμε το κεφάλι να μετακινείται ομοίως το πρόσωπο 
αλλά και το στόμα. Επίσης ρυθμίζουμε με το Pan Behind Tool το Anchor Point να 
βρίσκεται πάνω στο στόμα (LeeDanielsART, 2016).  

 
Eικόνα 4-36 Pre-compose layers 

Κάνω διπλό κλικ στο νέο composition stoma για να το επεξεργαστώ. Επιλέγω όλα τα 
layers που βρίσκονται μέσα με Ctrl+A και πατάω Alt+] με την βελόνα στο Τime 
Graph panel να είναι στη χρονική διάρκεια 0. Η επιλογή αυτή έχει σαν αποτέλεσμα 
να δίνει διάρκεια στο κάθε layer 1 frame-καρέ. Το composition έχει ρυθμιστεί να 
παίζει 25 frames το δευτερόλεπτο. (Eικόνα 4-37) 

 
Eικόνα 4-37 layers διάρκειας 1 frame 

Από το Application window επιλέγω Animation->Key frame Assistant-> 
Sequence Layer. Αυτό θα κάνει τα layer να εμφανίζονται χρονικά το ένα μετά το 
άλλο. Πηγαίνοντας στο τελευταίο layer στη σειρά επιλέγω από το πληκτρολόγιο το N 
και στη συνέχεια πηγαίνω στο Application Window και επιλέγω Composition-> Trim 
Comp to Work Area (εικόνα 4-38). Τώρα το composition μου περιορίστηκε σε αυτά 
τα καρέ. Αυτή η κίνηση θα περιορίσει τη χρονική διάρκεια του composition στον 
συνολικό αριθμό των frames που είναι οι εικόνες μου (LeeDanielsART, 2016). 
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Εικόνα 4-38 Trim comp to Work area 

Tώρα μπορώ να γυρίσω ξανά στο composition agent και να επιλέξω το layer 
stoma. Από την εργαλειοθήκη μου πάω στο Effect->Expression Controls-Slider 
Control. Έχοντας ακόμα επιλεγμένο το stoma πηγαίνω Layer->Time->Enable Time 
Remapping. Στο timeline panel στο layer stoma πατάμε το βελάκι προς τα κάτω και 
στο effect Time Remap πατάμε με Alt και κλικ το εικονίδιο του χρονομέτρου και με 
το Pick Whip Tool το ενώνουμε το Slider Control (εικόνα 4-39) (LeeDanielsART, 
2016). 

 
Εικόνα 4-39 Σύνδεση Pick Whip Tool με Slider Control, 

Εικόνα 4-40 Expression slider control 
 

Στην δεξιά πλευρά ανοίγει ένα σημείο όπου γράφει effect("Slider 
Control")("Slider"). Αυτό θα το αλλάξω σε a=effect("Slider Control")("Slider") και 
πατώντας Enter ακριβώς από κάτω framesToTime(a) (εικόνα 4-40). Στο Slider 
control πάνω κάνω δεξί κλικ Edit Value πατάω πάνω και στο πεδίο Value βάζω την 
τιμή 14 τα οποία είναι όσο σχήματα στόματος υπάρχουν σε αυτό το composition. Τα 
στόματα πλέον θα πρέπει να κατανεμηθούν ομοιόμορφα χρονικά μέσα από το εύρος 
που διαθέτει to slider control. Πατώντας το πλήκτρο U εμφανίζεται το layer Slider 
Control και πατώντας το χρονόμετρο ορίζω το πρώτο keyframe. Αμέσως μετά κάνω 
δεξί κλικ στο keyframe και επιλέγω Toggle Hold keyframe. Αυτό σημαίνει ότι τα 
κενά μεταξύ των επόμενων καρέ θα παγώσουν στα επιλεγμένα σχήματα των 
στομάτων που θα χρησιμοποιηθούν κάνοντας ευκολότερο των συγχρονισμό των 
χειλιών.(εικόνα 4-41) (LeeDanielsART, 2016) 
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Εικόνα 4-41 Toggle Hold Keyframes 

 

4.9 ΕΦΑΡΜΟΓΗ  “BONES”  ΣΤΑ ΔΑΧΤΥΛΑ 

Οι παλάμες όπως προαναφέρθηκε έγιναν σε ξεχωριστό project στο illustrator. 
Χρειάζονται τα πράγματα να είναι κάπως ομαδοποιημένα γιατί όταν στηθεί ο 
χαρακτήρας και προστεθεί η κίνηση μπορεί να προκληθεί σύγχυση. Πατώντας Ctrl+I 
γίνεται η εισαγωγή των σχεδιασμένων εικόνων στο Project Panel και ρυθμίζουμε τις 
παραμέτρους εισαγωγής σε composition και Layer Size όπως κάναμε και στο project 
agent. Ανοίγοντας το composition, όπως έκανα και στην περίπτωση χεριών και των 
ποδιών χρησιμοποίησα την επιλογή bones έτσι και εδώ θα κάνω την ίδια δουλειά, θα 
χρησιμοποιήσω το plugin Duik. Το χέρι είναι (RET80, 15) σχεδιασμένο σε ξεχωριστά 
layers επομένως τα δάχτυλα έχουν χωριστεί σε “finger 1”, “finger 2”, “finger 3”, 
“finger 4”, “finger 5”, και  “palm”. Συνδέω με το pick whip tool τα layers “finger 1”, 
“finger 2”, “finger 3”, “finger 4”, “finger 5” με το layer “palm”. Mε το Puppet pin 
tool πρόσθεσα στο “finger 1”, τα pins: “finger1 001”, “finger1 002”, “finger1 003”. 
Έπειτα πατώντας ξανά το layer “finger 1” στο Duik Panel δημιουργήθηκαν bones 
πάνω στα pins με την ονομασία: “C_finger 001”, “C_finger 002”, “C_finger 003”. 
Έπειτα επιλέγω “C_finger1 003”, το συνδέω με το pick whip tool με το “C_finger1 
002”, και “C_finger1 002” με το “C_finger1 001”. Στη συνέχεια επιλέγω το 
“C_finger1 003” και στο Duik Panel κάνω την επιλογή Controllers. Σχηματίστηκε 
επομένως controller το “C_B finger1 003”. Τέλος με πατημένο το πλήκτρο Ctrl 
επιλέγω με τη σειρά το “C_finger 003”, “C_finger 002”, “C_finger 001” και τελικό το 
“C_B finger1 003” και επιλέγω στο Duik panel “IK->2 Layer IK GOAL” και η 
σύνδεση είναι έτοιμη. Επιλέγω το “C_B finger1 003” στο duik Panel πατάω “Zero 
pos(0)”.  Εφαρμόζω ίδια διαδικασία για το υπόλοιπα δάχτυλα. (Εικόνα 4-42) Η 
διαδικασία αυτή γίνεται επίσης και για το άλλο χέρι. 
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Εικόνα 4-42 παράδειγμα «rigging» δεξιού χεριού 

 

4.10  ΣΥΝΔΕΣΗ ΤΩΝ ΠΑΛΑΜΩΝ ΜΕ ΤΟ COMPOSITION ΑGENT 

Αφού ρυθμίσαμε τις παλάμες σε ξεχωριστά compositions επιστρέφω στο 
composition agent. Από το project panel βρίσκω τα αντίστοιχα compositions για 
αριστερή και δεξιά παλάμη που μόλις επεξεργάστηκα και το σέρνω στο timeline 
panel του composition agent. Πρώτα από όλα ρυθμίζω το scale να είναι ομοιόμορφο 
με το μέγεθος του υπόλοιπου χεριού αφού δεν φτιάχτηκε εξ’αρχής πάνω στο σχέδιο 
του χαρακτήρα. Αφού το scale είναι πολύ μεγάλο το ρυθμίζω  στο 22.2, 22.2. 
Ρυθμίζω το Anchor Point να είναι στο καρπό του χεριού για να περιστρέφεται φυσικά 
και έπειτα το συνδέω το layer με τη χρήση του εργαλείου pick whip tool με το bone 
“B_hand L” για το αριστερό χέρι και “B_hand R” αντίστοιχα για το δεξί. To anchor 
point με το σημείο που έχει τοποθετηθεί το bone “B_hand L” θα πρέπει να 
ταυτίζονται. (εικόνα 4-43). Με αυτό τον τρόπο όταν θα μετακινήσω τους controllers 
που έχω δημιουργήσει για τα χέρια τα composition που προσθέσαμε αργότερα θα 
ακολουθούν φυσικά το χέρι. (Wilson, 2015) 

 
Εικόνα 4-43 Σύνδεση παλάμης-χεριού (composition agent) 

 

4.10 ΓΥΡΙΣΜΑ ΚΕΦΑΛΙΟΥ 

Από την αρχή της σχεδίασης έχουμε αφήσει του πρόσωπο του χαρακτήρα 
εκτός ορίων του κεφαλιού. Επόμενο βήμα είναι να δημιουργήσουμε μια 
μάσκα.Επιλέγουμε το layer “kefali” (Εικόνα 4-44) και πατάμε τη συντόμευση Ctrl+D 
ή από το Application “Window Edit -> Duplicate”. Αυτό θα δημιουργήσει ένα 
αντίτυπο του layer “kefali”,  το “kefali2” (LeeDanielsART, 2014). 



 

 

 

Εικόνα 4-44 

Στο κάτω μέρος του παραθύρου είναι το κουμπί 
επιλέγω. (εικόνα 4-45) 

Εικόνα 4-45 Duplicate το layer 

Έχοντας επιλεγμένο το 
"proswpo" ώστε να το καλύψει. 
αλλάζω το πεδίο “None” se Alpha
αποτέλεσμα το "proswpo" γίνει μάσκα μέσα στο

.
Εικόνα 

 
Tα φρύδια εξακολουθούν να είναι εκτός

ακολουθούμε την ίδια διαδικασία. Με 
δημιουργείται το layer “kefali 3
Στην συνέχεια το layer “aristero
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 βήμα 1 επιλέγουμε το layer "kefali" 

Στο κάτω μέρος του παραθύρου είναι το κουμπί “Toggle Switches/Modes

 
layer "kefali" και επιλογή Toggle Switches/Modes

Έχοντας επιλεγμένο το layer “kefali 2” το πηγαίνουμε πάνω από το 
ώστε να το καλύψει. Επιλέγω το layer "proswpo" και στην στήλη 

Alpha Matte “kefali2” (Εικόνα 4-46) Αυτό έχει σαν 
γίνει μάσκα μέσα στο “kefali2” (LeeDanielsART, 2014)

Εικόνα 4-46Alpha Matte “kefali 2" 

α φρύδια εξακολουθούν να είναι εκτός των ορίων του κεφαλιού. Επομένως 
ακολουθούμε την ίδια διαδικασία. Με ctrl+D κάνω duplicate το layer “kefali

3”. Το πάω πάνω ακριβώς από το layer "aristero
aristero frydi” το αλλάζω σε Alpha Matte “kefali 3” και είναι 

Modes”. Το 

Toggle Switches/Modes 

το πηγαίνουμε πάνω από το layer 
 TrkMat 

Αυτό έχει σαν 
, 2014). 

 

των ορίων του κεφαλιού. Επομένως 
kefali” οπότε 

aristero frydi". 
και είναι 
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έτοιμο. Την ίδια διαδικασία θα ακολουθήσω και για το layer “deksi frydi” αλλά και 
το στόμα. Κάτι πολύ βασικό για την μετέπειτα κίνηση είναι ότι τα φρύδια και το 
στόμα πρέπει να έχουν γίνει parent με το pick whip tool στο «proswpo», έτσι ώστε 
όταν μετακινούμε το πρόσωπο να ακολουθούν και τα υπόλοιπα μέλη του 
(LeeDanielsART, 2014). Η διάρκεια ενός composition, ενός layer ή ενός 
ανεπεξέργαστου υλικού αναπαρίσταται οπτικά στο Time Graph Panel. Στη γραμμή 
χρόνου, η κόκκινη βελόνα δείχνει το καρέ πού επεξεργάζεσαι και τo frame αυτό 
εμφανίζεται στο Composition Panel (Adobe Creative Team, 2012, σ. 25). 
Επιλέγοντας το layer “proswpo” την χρονική στιγμή 0:00:00:00 τοποθετούμε ένα 
keyframe στην ιδιότητα position. Σύροντας την βελόνα κατά μήκος του Time Graph 
Panel τη χρονική στιγμή 0:00:15:10, μετακινούμε το πρόσωπο αυτή τη φορά λίγο πιο 
δεξιά με το εργαλείο Selective Tool (V). Άρα τη χρονική στιγμή 0:00:00:00 το 
πρόσωπο θα βρίσκεται σε αυτή τη θέση (Εικόνα 4-47),  ενώ τη χρονική στιγμή 
0:00:15:10 θα «κοιτάει» δεξιά. (Εικόνα 4-48) 

Εικόνα 4-47 Γύρισμα κεφαλιού 0:00:00:00 - Εικόνα 4-48 0:00:15:10 κίνηση με keyframes 
 
Τώρα που ολοκληρώθηκε η σύνδεση του χαρακτήρα μπορώ να εφαρμόσω 

keyframes σε κάθε controller ξεχωριστά για να δώσω κίνηση. Παρακάτω δίνεται 
παράδειγμα κίνησης ενός δευτερολέπτου για το πώς εφαρμόζονται τα κλειδιά σε κάθε 
μέλος του σώματος στα σημεία μεταχείρησης controllers. Η επόμενη φωτογραφία 
απεικονίζει τον κύκλο περπατήματος του χαρακτήρα σε στατική θέση (εικόνα 4-49). 
Στο επόμενο βήμα γίνεται τοποθέτηση του composition  αυτού σε νέο composition 
που διαθέτει το φόντο μου και γίνεται αλλαγή θέσης ολόκληρου του χαρακτήρα κατά 
μήκος της σκηνής (εικόνα 4-50). Ο συνδυασμός αυτών των δύο συνθέτει σταδιακά  
τη νέα μου σκηνή. Για να ολοκληρωθεί μια σκηνή χρειάζεται επιπλέον τα ηχητικά και  
οπτικά τα οποία θα δούμε στη συνέχεια πως θα χρησιμοποιηθούνε. 



 

 

Εικόνα 4-49 agent composition
controllers

Εικόνα 4-50 τοποθέτηση του 
μετακίνηση του κατά μήκος της σκηνής.

 

4.11 ΔΗΜΙΟΥΡΓΙΑ 3D LAYER

Εικόνα 4-
Το δωμάτιο της υπηρεσίας έγινε με τη χρήση 

2012, pp. 248-249). Για να φτιαχτεί χρησιμοποιήθηκαν 
μεταχειρίστηκα στις 3 διαστάσεις στα πεδία 
στο Application window Layers
διαστάσεων. (Εικόνα 4-52) 
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composition- εφαρμογή keyframes στα σημεία μεταχείρησης

controllers- στατική θέση walk cycle 

( κύκλος περπατήματος) 

 
τοποθέτηση του composition agent σε άλλο compostion
μετακίνηση του κατά μήκος της σκηνής. 

LAYER KAI H CAMERA 

 
-51 το 3d δωμάτιο της υπηρεσίας 

Το δωμάτιο της υπηρεσίας έγινε με τη χρήση 3d layers (Adobe Creative
Για να φτιαχτεί χρησιμοποιήθηκαν 5 layers τα οποία 

στις 3 διαστάσεις στα πεδία position, orientation, scale . Πηγαίνοντας
Layers->New->Solid δημιουργείται μια επιφάνεια δύο 

μεταχείρησης 

compostion και 

Creative Team, 
τα οποία τα 
Πηγαίνοντας 

μια επιφάνεια δύο 
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Εικόνα 4-52 Δημιουργία solid 

 Πατώντας τη λειτουργία 3d layer  δίνεις τη δυνατότητα σε ένα 2d layer να 
μετατραπεί σε 3 διαστάσεις.Επομένως μπορώ να χειριστώ πλέον ένα layer κατά τους 
x’, y’, z’ άξονες. Με το Enter μετoνομάζουμε από “black solid” σε “patwma” και 
πατάμε στο πληκτρολόγιο τη συντόμευση R για να περιστρέψουμε το "patwma". 
Ρυθμίζουμε το πεδίο orientation  90 μοίρες να περιστραφεί κατά τον άξονα x’, 00  για 
y’, 00 για z’   και δίνουμε τιμή στο πεδίο position στους άξονες x’,y’ και z’ αντίστοιχα 
1935, 3268,2000. Το scale του θα αλλάξει σε 2750, 5418, 2750 και το Anchor point 
147, 170 , 0. Φτιάχνω άλλα τέσσερα solid ένα για κάθε τοίχο του δωματίου τον οποίο 
προσαρμόζω ανάλογα για να εφάπτεται με τον άλλο. Το ταβάνι έχει  Orientation 270, 
0, 0, Position 1935, 3268, 2000, Anchor point 319, 0.3, 0,  Scale 1179, 2466, 1179, ο 
Αριστερός τοίχος με Orientation 0, 90, 0 Position -1920, 1089, 2000, Anchor point 
2.78, 383, 0, Scale 907, 585, 200. Ο δεξής τοίχος Orientation 0,270,0  Position 5809, 
1089, 2000, Anchor point 1023, 383, 0, Scale 907, 585, 200. Το  After effects 
διαθέτει και άλλα παράθυρα που μπορείς να δεις διαφορετικές οπτικές γωνίες του 
σκηνικού που έχεις στήσει. Επιλέγω 2 views και Top στο composition panel για να 
μπορώ να δώ αν εφαρμόζουν σωστά τα layer μεταξύ τους. (Εικόνα 4-53) 

 
Εικόνα 4-53 2 Views-Top view δωματίου αριστερή πλευρά  του Composition Panel. 

O Αριστερός και δεξιός τοίχος έχουν παράθυρα τα οποία έγιναν με τη χρήση 
μάσκας. Έχοντας επιλεγμένο τον αριστερό τοίχο επιλέγουμε το εργαλείο Rectangle 
tool  και δημιουργούμε πάνω του ένα τετράγωνο για παράθυρο. (Adobe Creative 
Team, 2012, σσ. 184-193) Η πράξη αυτή αντί να αφήσει κενό στο σημείο του 
παραθύρου αντιθέτως θα κάνει ορατό μόνο ότι φαίνεται στο τετράγωνο. Για να 
διορθωθεί αυτό το πρόβλημα στο layer του τοίχου πατάω Μ για να μου εμφανίσει τις 



 

 

μάσκες. Στη μάσκα που εμφανίζεται επιλέγω 
το αποτέλεσμα. Τέλος τώρα που δημιούργησα τον σκελετό του δωματίου θα 
αντικαταστήσω τα 3d solid με φωτογραφίες. Από το 
του δωματίου επιλέγω τον τοίχο
βρίσκω και επιλέγω τη φωτογραφία που θα αντικαταστήσω και με 
στον επιλεγμένο τοίχο του composition
τους υπόλοιπους τοίχους. Από έξω από τους δύο τοίχους με
αριστερά και δεξιά φωτογραφίες του ουρανού ώστε να φαίνεται από μέσα από τα 
παράθυρα. (εικόνα 4-54)  

.
Εικόνα 4-54 Επιλογή μάσκας για την δημιουργία παραθύρου

Με βάση τη λογική των 
πρόγραμμα. Αφού έστησα το δωμάτιο τώρα θα χρησιμοποιήσω τη
Creative Team, 2012, pp. 269-271)
παράθυρο που ακολουθεί, επιλέγω 
σκηνικό μου τη κάμερα η οποία είναι έτοιμη για χρήση. Η κίνηση των χαρακτήρων 
γίνεται σε ξεχωριστά compositions
Αυτό σημαίνει ότι θα συμπεριφέρονται σαν 2
θέλω να μπορώ να περιστρέφω το χαρακτήρα από την όποια οπτική δείχνει για να 
είναι πάντα μέσα στο πλάνο. Επομένως όταν εντάξουμε το 
composition “ktirio eswteriko”
omposition agent. Τώρα ο χαρακτήρας θα μετακινείται προς όλους τους άξονες χωρίς 
περιορισμούς. (εικόνα 4-55) 

Εικόνα 4-5
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κα που εμφανίζεται επιλέγω Subtrack και αυτό θα μου αντιστρέψει 
Τέλος τώρα που δημιούργησα τον σκελετό του δωματίου θα 

με φωτογραφίες. Από το Timeline Panel του composition
του δωματίου επιλέγω τον τοίχο μου που θέλω να αντικαταστήσω. Στο Project
βρίσκω και επιλέγω τη φωτογραφία που θα αντικαταστήσω και με Alt τη σέρνω πάνω 

composition. Η αντικατάσταση έγινε. Εφαρμόζω σε όλους 
τους υπόλοιπους τοίχους. Από έξω από τους δύο τοίχους με τα παράθυρα τοποθετώ 
αριστερά και δεξιά φωτογραφίες του ουρανού ώστε να φαίνεται από μέσα από τα 

 
Επιλογή μάσκας για την δημιουργία παραθύρου 

Με βάση τη λογική των 3d layers έγιναν και τα υπόλοιπα 3d σκηνικά στ
ραμμα. Αφού έστησα το δωμάτιο τώρα θα χρησιμοποιήσω τη camera 

271). Πάω layer-> New-> Camera και πατάω πάνω στο 
παράθυρο που ακολουθεί, επιλέγω camera 15 mm και ΟΚ. Τώρα πλέον έχω μέσα στο 
σκηνικό μου τη κάμερα η οποία είναι έτοιμη για χρήση. Η κίνηση των χαρακτήρων 

compositions και εντάσσονται μετά μέσα στα σκηνικά (nesting
Αυτό σημαίνει ότι θα συμπεριφέρονται σαν 2d layer αλλά αφού θα έχω την κάμερα
θέλω να μπορώ να περιστρέφω το χαρακτήρα από την όποια οπτική δείχνει για να 

Επομένως όταν εντάξουμε το composition “agent
” θα ενεργοποιήσουμε τo κουμπί 3d layer για το 

Τώρα ο χαρακτήρας θα μετακινείται προς όλους τους άξονες χωρίς 

 
55 Κίνηση και περιστροφή της κάμερας. 

και αυτό θα μου αντιστρέψει 
Τέλος τώρα που δημιούργησα τον σκελετό του δωματίου θα 

composition 
Project Panel 
σέρνω πάνω 

. Η αντικατάσταση έγινε. Εφαρμόζω σε όλους 
τα παράθυρα τοποθετώ 

αριστερά και δεξιά φωτογραφίες του ουρανού ώστε να φαίνεται από μέσα από τα 

σκηνικά στo 
 (Adobe 

και πατάω πάνω στο 
και ΟΚ. Τώρα πλέον έχω μέσα στο 

σκηνικό μου τη κάμερα η οποία είναι έτοιμη για χρήση. Η κίνηση των χαρακτήρων 
nesting). 

έχω την κάμερα, 
θέλω να μπορώ να περιστρέφω το χαρακτήρα από την όποια οπτική δείχνει για να 

agent” στο 
για το c 

Τώρα ο χαρακτήρας θα μετακινείται προς όλους τους άξονες χωρίς 



 

 

 

4.12 ΜΕΡΙΚΑ ΑΠΟ ΤΑ ΟΠΤΙΚΑ ΕΦΕ

 

4.12.1 ΟΙ ΠΟΡΤΕΣ ΤΗΣ ΥΠΗΡΕΣΙΑΣ ΠΟΥ ΑΝΟΙΓΟΥΝ
 

Με τη μέθοδο των 3d layer τοποθετείται το 
ανοίγουν στην είσοδο του δωματίου.
duplicate το layer αυτό. Στο πρώτο
Team, 2012, p. 201) καλύπτοντας το αριστερό φύλο της πόρτας όπως φαίνεται και 
στην εικόνα (Εικόνα 4-56). 

Εικόνα 4-5

 
Από προεπιλογή η μάσκα είναι σε λειτουργία

2012, p. 188) που σημαίνει ότι υπάρχει μέσα στην μάσκα θα φαίνεται ενώ τα 
υπόλοιπα αποκρύπτονται. Το ίδιο θα κάνω και για το δεύτερο αντίγραφο, θα 
εφαρμόσω τη μάσκα στο δεξί φύλλο της πόρτας.
τα δύο φύλλα της πόρτας για να φαίνονται τα υπόλο
σε λειτουργία “Subtract” ενώ θα είναι κάτω από τα αλλά δύο
Panel. Τώρα στο μενού επιλογών της μάσκας επιλέγω το 
keyframe θα δοθεί απλά και μόνο πατώντας το χρονόμετρο στο 
κρατήσουμε την αρχική θέση που έχει η πόρτα.
αργότερα και με επιλεγμένο το 
μέχρι να φτάσει το επιθυμητό άνοιγμα. Η ίδια διαδικασία ισχύει και για το άλλο 
φύλλο της πόρτας. Η κίνηση των φύλλων
ταυτόχρονα όπου είναι και το ζητούμενο.
για το άνοιγμα της πόρτας  θα ορίστει από την χρονική διάρκεια του ηχητικού εφέ 
που θα προσθέσω στο κεφάλαιο 4.12.2.

4.12.2 ΣΥΓΧΡΟΝΙΣΜΟΣ ΗΧΗΤΙΚΩΝ ΕΦΕ
Στο παράδειγμα που αναλύθηκε παραπάνω θα προσθέσουμε ένα ηχητικό εφέ. 

Από την βιβλιοθήκη του YouTube
ακούγεται όταν ανοίγουν οι πόρτες. Αυτό που καθορίζει την χρονική δ
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ΜΕΡΙΚΑ ΑΠΟ ΤΑ ΟΠΤΙΚΑ ΕΦΕ 

ΟΙ ΠΟΡΤΕΣ ΤΗΣ ΥΠΗΡΕΣΙΑΣ ΠΟΥ ΑΝΟΙΓΟΥΝ 

τοποθετείται το layer οι πόρτες της υπηρεσίας που 
ανοίγουν στην είσοδο του δωματίου. Θα χρειαστώ ακόμα δύο φορές να κάνω 

πρώτο θα χρησιμοποιήσουμε μάσκα (Adobe Creative
αλύπτοντας το αριστερό φύλο της πόρτας όπως φαίνεται και 

 
56 εφαρμογή Μάσκας στην πόρτα 

Από προεπιλογή η μάσκα είναι σε λειτουργία Αdd (Adobe Creative
σημαίνει ότι υπάρχει μέσα στην μάσκα θα φαίνεται ενώ τα 

υπόλοιπα αποκρύπτονται. Το ίδιο θα κάνω και για το δεύτερο αντίγραφο, θα 
εφαρμόσω τη μάσκα στο δεξί φύλλο της πόρτας. Στο τρίτο η μάσκα θα καλύψει και 

για να φαίνονται τα υπόλοιπα σημεία του τοίχου και 
θα είναι κάτω από τα αλλά δύο layers στο timeline

Τώρα στο μενού επιλογών της μάσκας επιλέγω το position. Το πρώτο 
θα δοθεί απλά και μόνο πατώντας το χρονόμετρο στο position 

κρατήσουμε την αρχική θέση που έχει η πόρτα. Μετακινούμε την βελόνα λίγα 
αργότερα και με επιλεγμένο το selective tool μετακινούμε με τα βελάκια αριστερά 
μέχρι να φτάσει το επιθυμητό άνοιγμα. Η ίδια διαδικασία ισχύει και για το άλλο 

τας. Η κίνηση των φύλλων πρέπει κατηγορηματικά να εκτελείται 
ταυτόχρονα όπου είναι και το ζητούμενο. Η τοποθέτηση των keyframes στις μάσκες
για το άνοιγμα της πόρτας  θα ορίστει από την χρονική διάρκεια του ηχητικού εφέ 
που θα προσθέσω στο κεφάλαιο 4.12.2. 

ΣΥΓΧΡΟΝΙΣΜΟΣ ΗΧΗΤΙΚΩΝ ΕΦΕ 
Στο παράδειγμα που αναλύθηκε παραπάνω θα προσθέσουμε ένα ηχητικό εφέ. 

YouTube θα χρησιμοποιήσω ένα ηχητικό εφέ για να 
οι πόρτες. Αυτό που καθορίζει την χρονική διάρκεια για την

πόρτες της υπηρεσίας που 
Θα χρειαστώ ακόμα δύο φορές να κάνω 

Creative 
αλύπτοντας το αριστερό φύλο της πόρτας όπως φαίνεται και 

Creative Team, 
σημαίνει ότι υπάρχει μέσα στην μάσκα θα φαίνεται ενώ τα 

υπόλοιπα αποκρύπτονται. Το ίδιο θα κάνω και για το δεύτερο αντίγραφο, θα 
ο τρίτο η μάσκα θα καλύψει και 

 θα μπει 
timeline 

. Το πρώτο 
 για να 

Μετακινούμε την βελόνα λίγα frames 
μετακινούμε με τα βελάκια αριστερά 

μέχρι να φτάσει το επιθυμητό άνοιγμα. Η ίδια διαδικασία ισχύει και για το άλλο 
πρέπει κατηγορηματικά να εκτελείται 

στις μάσκες 
για το άνοιγμα της πόρτας  θα ορίστει από την χρονική διάρκεια του ηχητικού εφέ 

Στο παράδειγμα που αναλύθηκε παραπάνω θα προσθέσουμε ένα ηχητικό εφέ. 
θα χρησιμοποιήσω ένα ηχητικό εφέ για να 

ιάρκεια για την 



 

 

ολοκλήρωση του ανοίγματος των φύλλων της πόρτας είναι η χρονική διάρκεια του 
ηχητικού εφέ. Εισάγω λοιπόν το ηχητικό στο 
ηχητικό βλέπω ότι διαρκεί δύο δευτερόλεπτα και δέκα 
φαίνεται και στην εικόνα 4-57
περιμένει να ανοίξουν οι πόρτες. Εκείνη την χρονική στιγμή μετακινώ την βελόνα 
στο Time Graph Panel και σύρω το ηχητικό ώστε να ξεκινάει από εκείν
Άρα και το πρώτο keyframe για
πόρτες  (με μάσκες πλέον) θα τοποθετηθεί εκεί που ξεκινά το ηχητικό και το δεύτερο 
εκεί που τελειώνει. Η κίνηση πλέον έχει συγχρονιστεί με τον ήχο.
για να συγχρονίζω τέλεια τα ηχητικά με τα εκάστοτε γραφικ
επιλογών του ήχου, στην ιδιότητα 
παρατηρώ την κυματομορφή πότε αρχίζει ή πότε τελειώνει ή παραδείγματος χάριν 
πότε ένα σημείο είναι πιο δυνατό και είναι πολύ σημαντικό για να δείξουμε κάτι. 
Τέλος με τη χρήση Ctrl και σύροντας τη βελόνα κατά μήκος του 
μπορείς να ακούσεις τον ήχο καρέ
δεν θέλω να ακούγεται μπορώ να το κόψω με τη χρήση συντόμευσης 

Εικόνα 4-57 waveform

 

4.12.3 ΦΩΤΑ ΠΟΥ ΑΝΑΒΟΣΒΗΝΟΥΝ
 
Τα φώτα δημιουργήθηκαν πάνω σε

το μενού θα πάω Layer->New->

  
Εικόνα

Επιλέγω spot light, Intensity: 46%, Cone Angle: 90%, Cone Feather:100%
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ήρωση του ανοίγματος των φύλλων της πόρτας είναι η χρονική διάρκεια του 
ηχητικού εφέ. Εισάγω λοιπόν το ηχητικό στο Timeline Panel της σύνθεσης μου. Το 
ηχητικό βλέπω ότι διαρκεί δύο δευτερόλεπτα και δέκα frames. Βάση σεναρίου όπως 

7 ο κατάσκοπος παρέκαμψε τον κωδικό εισόδου και 
περιμένει να ανοίξουν οι πόρτες. Εκείνη την χρονική στιγμή μετακινώ την βελόνα 

και σύρω το ηχητικό ώστε να ξεκινάει από εκείνο το 
για το πεδίο position των layers που απεικονίζουν τις 

πόρτες  (με μάσκες πλέον) θα τοποθετηθεί εκεί που ξεκινά το ηχητικό και το δεύτερο 
Η κίνηση πλέον έχει συγχρονιστεί με τον ήχο. Άλλος ένας τρόπος 

για να συγχρονίζω τέλεια τα ηχητικά με τα εκάστοτε γραφικά βρίσκεται στο
επιλογών του ήχου, στην ιδιότητα waveform. Πατώντας το βέλος να ανοίξει, 
παρατηρώ την κυματομορφή πότε αρχίζει ή πότε τελειώνει ή παραδείγματος χάριν 
πότε ένα σημείο είναι πιο δυνατό και είναι πολύ σημαντικό για να δείξουμε κάτι. 

και σύροντας τη βελόνα κατά μήκος του Time Graph
μπορείς να ακούσεις τον ήχο καρέ-καρέ στην χρονική στιγμή που βρίσκεται. Αν κάτι 
δεν θέλω να ακούγεται μπορώ να το κόψω με τη χρήση συντόμευσης Alt+ ]. 

 
waveform- συγχρονισμός ηχητικών εφέ με γραφικά 

ΦΩΤΑ ΠΟΥ ΑΝΑΒΟΣΒΗΝΟΥΝ 

Τα φώτα δημιουργήθηκαν πάνω σε ένα από τα πλέον έτοιμα βίντεο μου
>Light (Adobe Creative Team, 2012, pp. 284-286)

 
Εικόνα 4-58 Δημιουργία spot light 

spot light, Intensity: 46%, Cone Angle: 90%, Cone Feather:100% 

ήρωση του ανοίγματος των φύλλων της πόρτας είναι η χρονική διάρκεια του 
της σύνθεσης μου. Το 
. Βάση σεναρίου όπως 

ο κατάσκοπος παρέκαμψε τον κωδικό εισόδου και 
περιμένει να ανοίξουν οι πόρτες. Εκείνη την χρονική στιγμή μετακινώ την βελόνα 

 σημείο. 
απεικονίζουν τις 

πόρτες  (με μάσκες πλέον) θα τοποθετηθεί εκεί που ξεκινά το ηχητικό και το δεύτερο 
Άλλος ένας τρόπος 

στο μενού 
Πατώντας το βέλος να ανοίξει, 

παρατηρώ την κυματομορφή πότε αρχίζει ή πότε τελειώνει ή παραδείγματος χάριν 
πότε ένα σημείο είναι πιο δυνατό και είναι πολύ σημαντικό για να δείξουμε κάτι. 

Graph Panel 
καρέ στην χρονική στιγμή που βρίσκεται. Αν κάτι 

ένα από τα πλέον έτοιμα βίντεο μου. Από 
286). 



 

 

Επόμενο βήμα ρυθμίζω το position
light layer επιλέγω το βελάκι προς τα κάτω και επιλέγω 
intensity. Πατάω το χρονόμετρο και ρυθμίζω το πρώτο 
βελόνα 1 δευτερόλεπτο μετά και βάζω πάλι 
ανάμεσα στα δύο key frames, 12 
διαδικασία να διαρκεί όσο και ο συναγερμός οπότε κάνω τα εξής: Με κρατημένο το 
κουμπί Alt κάνω κλικ πάνω στο χρονόμετρο του πεδίου 
που εμφανίζεται στη συνέχεια και εμφανίζονται κάποιες έτοιμες εκφράσεις
Property-> loopOutDuration(type
πράξη θα επαναλαμβάνει το μοτίβο των
χρειάζεται να ρυθμίζω χειροκίνητα

Εικόνα 4-59 menu expressions:

Τέλος ρυθμίζουμε τη χρονική διάρκεια
δευτερόλεπτα μέχρι να τελειώσει η σκηνή. (εικόνα 

Εικόνα 4-60 
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position 1886,1, -33,9, -226,4 .Στο μενού επιλογών του 
επιλέγω το βελάκι προς τα κάτω και επιλέγω  από το light option το πεδίο 
Πατάω το χρονόμετρο και ρυθμίζω το πρώτο key frame στο 0 % . Σύρω την 

βελόνα 1 δευτερόλεπτο μετά και βάζω πάλι key frame 0 %. Γυρίζω πίσω την βελόνα 
, 12 frames πριν και βάζω τιμή 338 %. Θέλουμε αυτή η 

ιαδικασία να διαρκεί όσο και ο συναγερμός οπότε κάνω τα εξής: Με κρατημένο το 
κάνω κλικ πάνω στο χρονόμετρο του πεδίου intensity. Πατάμε το βελάκι

που εμφανίζεται στη συνέχεια και εμφανίζονται κάποιες έτοιμες εκφράσεις. Επιλέγω
type = "cycle", duration = 0). (Εικόνα 4-59) 

ι το μοτίβο των keyframes για όσο διαρκεί το εφέ, χωρίς να 
χρειάζεται να ρυθμίζω χειροκίνητα (LeeDanielsART, 2015). 

 
: Property-> loopOut(type = "cycle", numKeyframes = 

0) 

Τέλος ρυθμίζουμε τη χρονική διάρκεια του Layer Light να διαρκεί για λίγα 
δευτερόλεπτα μέχρι να τελειώσει η σκηνή. (εικόνα 4-60)  

 
 Ρύθμιση Χρονικής διάρκειας-Μήκος Layer 

Στο μενού επιλογών του 
το πεδίο 

. Σύρω την 
πίσω την βελόνα 

πριν και βάζω τιμή 338 %. Θέλουμε αυτή η 
ιαδικασία να διαρκεί όσο και ο συναγερμός οπότε κάνω τα εξής: Με κρατημένο το 

Πατάμε το βελάκι 
Επιλέγω 
 Αυτή η 

, χωρίς να 

loopOut(type = "cycle", numKeyframes = 

να διαρκεί για λίγα 



 

 

4.12.4 ΤΟ ΕΦΕ ΤΗΣ ΧΡΟΝΟΠΥΛΗΣ ΜΕ ΤΗΝ ΧΡΗΣΗ Τ
TRAPCODE PARTICULAR

 
Εικόνα 4

Στη συνέχεια θα αναλυθεί πως έγινε το εφέ της χρονοπύλης
επιλέγω “Layer->New->Light”
“Point” και πατάω ΟΚ. Στη συνέχεια θα δημιουργήσουμε ένα νέο 
πάλι  Layer->New->Solid, το ονομάζω 

το Ellipse tool  και με επιλεγμένο το 
Πατώντας το πλήκτρο Μ στο πληκτρολόγιο θα εμφανιστεί το μενού επιλογών για την 
μάσκα. Επιλέγοντας το πεδίο “
Πηγαίνω ξανά στο layer “Emitter
Τώρα εμφανίστηκαν στο Τimeline
δευτερόλεπτο το καθένα και φτάνουν μέχρι τα δύο δευτερόλεπτα. Θέλω να διαρκούν 
μισό δευτερόλεπτο οπότε θα τα μετακινήσω ώστε να διαρκούν τόσο. Στη συνέχεια θα 
επιλέξω τα keyframes και θα τα αντιγράψω με 
δείκτη τρέχοντος χρόνου να είναι στο μισό δευτερόλεπτο πατώ 
Ctrl+V για επικόλληση μέχρι το τέλος του 
ουσιαστικά τον τρόπο έχουμε δημιουργήσει μι
κυκλικά. Επιλέγω πάλι το solid
Presets ψάχνω το εφέ Particular
Project Panel εμφανίζεται ακριβώς το πάνελ 
και θα ρυθμίσω τις παραμέτρους για το εφέ 
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ΤΗΣ ΧΡΟΝΟΠΥΛΗΣ ΜΕ ΤΗΝ ΧΡΗΣΗ ΤΟΥ PLUGIN
PARTICULAR 

 

 
Εικόνα 4-61 Η χρονοπύλη 

Στη συνέχεια θα αναλυθεί πως έγινε το εφέ της χρονοπύλης . Από το μενού 
”. Το ονομάζω “Emitter”, επιλέγω “Light 

και πατάω ΟΚ. Στη συνέχεια θα δημιουργήσουμε ένα νέο layer, οπότε πάω 
το ονομάζω “Particle” και πατάω “ΟΚ”. Μετά θα επιλέξω 

και με επιλεγμένο το layer “Particle” θα δημιουργήσω μια μάσκα. 
Πατώντας το πλήκτρο Μ στο πληκτρολόγιο θα εμφανιστεί το μενού επιλογών για την 

“Mask Path” πατάω πάνω στο μενού “Edit->
Emitter”, επιλέγω το position και κάνω “Edit->

imeline Graph Panel τέσσερα κλειδιά που ισαπέχουν μισό 
δευτερόλεπτο το καθένα και φτάνουν μέχρι τα δύο δευτερόλεπτα. Θέλω να διαρκούν 
μισό δευτερόλεπτο οπότε θα τα μετακινήσω ώστε να διαρκούν τόσο. Στη συνέχεια θα 

και θα τα αντιγράψω με “Edit->Copy” ή Ctrl+C και με τον 
δείκτη τρέχοντος χρόνου να είναι στο μισό δευτερόλεπτο πατώ “Edit->Paste

για επικόλληση μέχρι το τέλος του Timeline Graph Panel. Με αυτό 
ουσιαστικά τον τρόπο έχουμε δημιουργήσει μια φωτεινή πηγή που πηγαινοέρχεται 

solid με το όνομα Particle και στο παράθυρο Effects
Particular και το εφαρμόζω επάνω του. Δίπλα ακριβώς από το 

εμφανίζεται ακριβώς το πάνελ Effect Controls. Εκεί θα επεξεργαστώ 
και θα ρυθμίσω τις παραμέτρους για το εφέ Particular (Rusholme Productions, 2016)

PLUGIN 

Από το μενού 
 Type”: 

οπότε πάω 
Μετά θα επιλέξω 

θα δημιουργήσω μια μάσκα. 
Πατώντας το πλήκτρο Μ στο πληκτρολόγιο θα εμφανιστεί το μενού επιλογών για την 

>Copy”. 
>Paste”. 

τέσσερα κλειδιά που ισαπέχουν μισό 
δευτερόλεπτο το καθένα και φτάνουν μέχρι τα δύο δευτερόλεπτα. Θέλω να διαρκούν 
μισό δευτερόλεπτο οπότε θα τα μετακινήσω ώστε να διαρκούν τόσο. Στη συνέχεια θα 

και με τον 
Paste” ή 
Με αυτό 

α φωτεινή πηγή που πηγαινοέρχεται 
Effects and 

και το εφαρμόζω επάνω του. Δίπλα ακριβώς από το 
κεί θα επεξεργαστώ 

, 2016). 



 

 

Εικόνα 4
Ανοίγω την καρτέλα Emitter

Για το πεδίο “Emitter Type
δημιουργήθηκαν φωτεινά σωματίδια που γυρνάνε κυκλικά. Στη συνέχεια θα 
ρυθμίσουμε το πεδίο “Velocity
Size Y” στο “0”. Επόμενο βήμα ανοίγουμε την καρτέλα 
πεδίο “Life [sec]” στο “1.3”, το πεδίο 
στο “20”. Από την καρτέλα 
καρτέλα Motion Blur ρυθμίζω το πεδίο 
1000. Επόμενο βήμα είναι να κάνω ένα νέο αντίγραφο το 
συντόμευση Ctrl+D. Το νέο αντίγραφο πή
ελαφρώς τις ρυθμίσεις του. Στη καρτέλα 
Model” από “Bounce” σε “Air
περιστρέψω το πεδίο z rotation
“Particle 2” πατάω Ctrl+D για να φτιάξω το νέο αντίγραφο 
αλλάξω ελαφρώς τις ρυθμίσεις. Στην καρτέλα 
rotation κατά “1+11 μοίρες” .Κάνω 
ως έχει (Rusholme Productions, 2016)

 

4.12.5 ΕΙΣΑΓΩΓΙΚΟ INTRO 
 
Αρχικά θα ανοίξω (JHereM

δώσω όνομα Text intro. Επιλέγω
Composition Panel με γραμματοσειρά
επιλέγω χρώμα R:111 G:255 B:150  >
στο κέντρο του εγγράφου .  
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Εικόνα 4-62 Trapcode Particular 

Emitter και στο πεδίο “Particles/sec” δίνω την τιμή 2000. 
Type” επιλέγω “Light(s)”. Με αυτή την ενέργεια 

δημιουργήθηκαν φωτεινά σωματίδια που γυρνάνε κυκλικά. Στη συνέχεια θα 
Velocity” στο “-150”, “Emitter Size X”  στο “200”, “

. Επόμενο βήμα ανοίγουμε την καρτέλα Particle και ρυθμίζουμε το 
, το πεδίο “Size” στο “12” και το “Opacity Random

. Από την καρτέλα Physics ρυθμίζω τα πεδία “Gravity”: “300”
ρυθμίζω το πεδίο Motion Blur σε On και το Shutter

1000. Επόμενο βήμα είναι να κάνω ένα νέο αντίγραφο το solid Particle
. Το νέο αντίγραφο πήρε το όνομα “Particle 2” και θα αλλάξω 

ελαφρώς τις ρυθμίσεις του. Στη καρτέλα Physics θα αλλάξω το πεδίο “
Air”. Σειρά έχει η καρτέλα World Transform 

rotation κατά “203” μοίρες. Τώρα έχοντας επιλεγμένο το 
για να φτιάξω το νέο αντίγραφο “Particle3”. Πάλι θ

αλλάξω ελαφρώς τις ρυθμίσεις. Στην καρτέλα World Transform ρυθμίζω το πεδίο  
.Κάνω duplicate το layer άλλες δυο φορές και το αφήνω 

, 2016). 

JHereM, 2016) ένα νέο Composition Ctrl+N και 

Επιλέγω το Horizontal Type tool  και γράφω πάνω
γραμματοσειρά Consolas και χρώμα και στο πεδίο Fill

:150  >Η ΜΗΧΑΝΗ ΤΟΥ ΧΡΟΝΟΥ και το τοποθετώ

 

δίνω την τιμή 2000. 
. Με αυτή την ενέργεια 

δημιουργήθηκαν φωτεινά σωματίδια που γυρνάνε κυκλικά. Στη συνέχεια θα 
“Emitter 

και ρυθμίζουμε το 
Random [%]” 

”. Στην 
Shutter Angle: 
Particle με τη 
και θα αλλάξω 

“Physics 
 και θα 

μοίρες. Τώρα έχοντας επιλεγμένο το 
. Πάλι θα 

ρυθμίζω το πεδίο  z 
άλλες δυο φορές και το αφήνω 

 θα του 

πάνω στο 
Fill Color 
τοποθετώ 
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Εικόνα 4-63 Horizontal Type tool 

Πατώντας πάνω στο κείμενο στο Timeline Panel το βελάκι προς τα κάτω 
βλέπω το Πεδίο Text και στη δεξιά πλευρά του το πεδίο Animate με ένα βελάκι δεξιά 
του. Πατάω πάνω του και επιλέγω Opacity. Εμφανίζεται η επιλογή Animator1 και 
ανοίγω την καρτέλα Advanced για να ρυθμίσω παραμέτρους στο Opacity 0%. Στην 
καρτέλα Range Selector 1 ρυθμίζω Start στο frame 0 κλειδί 0% και στο frame 
0:00:01:17 κλειδί 100%. Στο Πεδίο shape ρυθμίζω Smoothness 0 %. Από το πάνελ 
Effect and Presets επιλέγω το εφέ Glow. Στο πεδίο Glow Radius βάζω 63.Μετά πάω 
Effect->Generate->Grid. Στο πεδίο Blending Mode επιλέγω Stencil Alpha και 
τσεκάρω το πεδίο Invert Grid. Επιλέγω από το πεδίο Size From->Width and Height 
Sliders. Δίνω τιμή στο πεδίο Width->5 και στο Height->5 και στο Border->2.Mε 
Ctrl+D κάνω άλλα δύο αντίγραφα το κείμενο και αλλάζω το περιεχόμενο κάνοντας 
κλικ στα γράμματα σε >After effects>Adobe Illustrator>Adobe Photoshop και 
>Μυστική Υπηρεσία>Ώρα 19:47. Έχοντας επιλεγμένο το κείμενο πατάω από το 
Application Window Layer->Pre-compose (Ctrl+Shift+C). Στο παράθυρο που ανοίγει 
δίνω το όνομα B και πατάω ΟΚ. Μόλις γίνει αυτό με Ctrl+D δημιουργώ άλλα δύο 
αντίγραφα. Μετονομάζω το ένα G και το άλλο R. Επιλέγω την σύνθεση R  και πάω 
Effect->Color Correction->Channel Mixer.Στο Effect Control πάνελ υπάρχει το εφέ 
Channel Mixer. Θα αλλάξω τα πεδία Green-Green από 100 σε 0 και Blue-Blue 
απο100 σε 0.Θα μείνει μόνο η τιμή Red-Red 100. Κάνω κλικ στη σύνθεση με το 
όνομα G στο Timeline Panel. Θα εφαρμόσω επίσης το εφέ Channel Mixer. Εδώ θα 
αλλάξει το πεδίο Red-Red από 100 σε 0 , το Green-Green σε 100 ενώ το Blue-Blue 
από 100 θα πάει 0. Επιλέγω τη σύνθεση B στο Timeline Panel, περνάω το εφέ 
Channel Mixer και μηδενίζω όλες τις τιμές εκτός από το πεδίο Blue-Blue που δίνω 
τιμή 100. Έπειτα επιλέγω τη σύνθεση R και G και στο πεδίο Mode αλλάζω από None 
σε Screen.( Εικόνα 4-63) (JHereM, 2016) 



 

 

Εικόνα 

Στη συνέχεια την σύνθεση 
διακρίνω τα κείμενα τη σύνθεσης που δημιούργησα στα προηγούμενα βήματα. 
Πατώντας το πρώτο κείμενο βρίσκω την επιλογή 
εικονίδιο του χρονομέτρου στο 
παράθυρο για να γράψουμε script
θα το σβήσουμε και θα γράψουμε
timeToFrames(time)%10*transform.opacity
αναβοσβήνει πολύ γρήγορα. Θα το κάνω αντιγραφή και επικόλληση για όλα τα 
κείμενα μου στο πεδίο Opacity. 

Εικόνα 4-65 timeToFrames(time)%10*transform.opacity.

Επόμενο βήμα είναι να σχεδιαστεί το φόντο. Για αυτό το λόγο θα φτιάξω ένα 
solid. Από ψηλά στο μενού πάω 
R:0,G:11,B:12 και πατάω ΟΚ. Στη συνέχεια
επιλεγμένο το BG  πατάω Τ στο πληκτρολόγιο για την επιλογή 
κλικ πατάω το εικονίδιο του χρονομέτρου στο 
timeToFrames(time)%10*transform
στο Rectangle Tool και δημιουργείται μια μάσ
του Composition Panel. Πατάω Μ για να μου εμφανίσει το μενού της Μάσκας. Δίνω
τιμή -90 pixels στο Mask Expansion
Timeline Panel κάνω δεξί κλικ
Του εφαρμόζω Glow Effect και
Intensity 0,5. Τώρα θα φτιάξω ένα νέο 
οποίο και θα το κάνω αόρατο απενεργοποιώντας το εικονίδιο με το ματάκι.
επιλεγμένο το Audio πηγαίνω Effect
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 4.64 Screen Mode για R και G 

Στη συνέχεια την σύνθεση R και θα κάνω διπλό κλικ. Τώρα μπορώ να 
διακρίνω τα κείμενα τη σύνθεσης που δημιούργησα στα προηγούμενα βήματα. 
Πατώντας το πρώτο κείμενο βρίσκω την επιλογή Opacity. Με Alt και κλικ πατάω το 
εικονίδιο του χρονομέτρου στο Opacity. Στο Timeline Graph Panel ανοίγει το 

script. Βλέπουμε ήδη ότι γράφει transform Opacity
θα το σβήσουμε και θα γράψουμε την έκφραση 
timeToFrames(time)%10*transform.opacity. Αυτό θα κάνει το κείμενο να 
αναβοσβήνει πολύ γρήγορα. Θα το κάνω αντιγραφή και επικόλληση για όλα τα 

 (JHereM, 2016) 

 
timeToFrames(time)%10*transform.opacity. 

Επόμενο βήμα είναι να σχεδιαστεί το φόντο. Για αυτό το λόγο θα φτιάξω ένα 
Από ψηλά στο μενού πάω Layer->New->Solid (Ctrl+Y) και διαλέγω χρώμα 

και πατάω ΟΚ. Στη συνέχεια το ονομάζω BG και πατάω ΟΚ. Με 
πατάω Τ στο πληκτρολόγιο για την επιλογή Opacity. Με 

κλικ πατάω το εικονίδιο του χρονομέτρου στο Opacity. Θα γράψω την έκφραση
transform.opacity.Με επιλεγμένο το BG κάνω διπλό κλικ 

και δημιουργείται μια μάσκα ακριβώς στα όρια του παραθύρου 
Πατάω Μ για να μου εμφανίσει το μενού της Μάσκας. Δίνω

Expansion και 168.0 , 168.0 στο Mask Feather. 
κλικ New->Adjustment Layer και το ονομάζω Radiance. 
και στα πεδία Glow Radius δίνω τιμή 27 και

Τώρα θα φτιάξω ένα νέο Solid το οποίο και θα ονομάσω Audio
οποίο και θα το κάνω αόρατο απενεργοποιώντας το εικονίδιο με το ματάκι.

Effect->Audio->Tone. Επιλέγω στο πεδίο Triangle

Τώρα μπορώ να 
διακρίνω τα κείμενα τη σύνθεσης που δημιούργησα στα προηγούμενα βήματα. 

και κλικ πατάω το 
ανοίγει το 

Opacity αλλά 
την έκφραση 

Αυτό θα κάνει το κείμενο να 
αναβοσβήνει πολύ γρήγορα. Θα το κάνω αντιγραφή και επικόλληση για όλα τα 

Επόμενο βήμα είναι να σχεδιαστεί το φόντο. Για αυτό το λόγο θα φτιάξω ένα 
και διαλέγω χρώμα 
και πατάω ΟΚ. Με 

Με Alt και 
έκφραση 

κάνω διπλό κλικ 
κα ακριβώς στα όρια του παραθύρου 

Πατάω Μ για να μου εμφανίσει το μενού της Μάσκας. Δίνω 
Feather. Στο 

Radiance. 
και Glow 
Audio το 

οποίο και θα το κάνω αόρατο απενεργοποιώντας το εικονίδιο με το ματάκι. Με 
Triangle στο 



 

 

πεδίο Waveform Options. Με 
συμπληρώνω στο παράθυρο εκφράσεων 
timeToFrames(time)%2*effect("
της αναφοράς δεν βρέθηκε.    (

 

4.12.6 ΤΟ ΕΦΕ ΣΦΡΑΓΙΔΑ 
 

Αρχικά φτιάχνω ένα νέο 
“Layer->New->Solid” και το χρωματίζω κόκκινο. Στο 
Rectangle tool και φτιάχνω μια μάσκα. Με 
επιλέγω την λειτουργία “Subtract
το μενού επιλογών της Μάσκας. Στο πεδίο 
συνέχεια επιλέγω το Ellipse Tool
περιγράμματος και τo θέτω σε 
μάσκες άλλες με “Subtract” Mode
αποτέλεσμα όπως φαίνεται στη φωτογραφία παρακάτω
(εικόνα 4-66). 

Εικόνα 4-66 Εφαρμογή Μάσκας για την δημιουργία σφραγίδας

Στην συνέχεια επιλέγω το 
τετραγώνου “ΚΑΤΑΣΚΟΠΟΣ”
εναλλαγή “Add” και “Subtract”
το πρώτο μου solid και στο πάνελ 
Δίνω τιμή για το πεδίο Border 15 
Edges πατάω Ctrl+C για αντιγραφή και επικόλληση στο κείμενο ΚΑΤΑΣΚΟΠΟΣ. 
Τώρα και το κείμενο θα έχει το ίδιο εφέ

Εικόνα 5
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Με Alt και κλικ στο χρονόμετρο του πεδίου 
συμπληρώνω στο παράθυρο εκφράσεων 

("Tone")("Level")Σφάλμα! Το αρχείο προέλευσ
(JHereM, 2016) 

Αρχικά φτιάχνω ένα νέο composition και το ονομάζω Σφραγίδα. Πηγαίνω 
και το χρωματίζω κόκκινο. Στο solid που έφτιαξα, επιλέγω το 

και φτιάχνω μια μάσκα. Με Ctrl+D κάνω αντίγραφο τη μάσκα και 
Subtract” . Πατάω τη συντόμευση Μ για να μου εμφανίσει 

το μενού επιλογών της Μάσκας. Στο πεδίο Mask Expansion  δίνω τιμή      – 
Tool και σχηματίζω ένα κύκλο σε τυχαίο σημείο του 

θέτω σε “Subtract” Mode. Δημιουργώ και άλλες κυκλικές 
Mode και άλλες με “Add” μέχρι να υπάρχει το επιθυμητό 

αίνεται στη φωτογραφία παρακάτω. (Fargas Studio, 2015)

 

Εφαρμογή Μάσκας για την δημιουργία σφραγίδας 

Στην συνέχεια επιλέγω το Horizontal Type Tool και γράφω στο κέντρο του 
”. Ακολουθώ την ίδια διαδικασία με τις μάσκες με 
” για να έχω το ίδιο οπτικό αποτέλεσμα. Επιλέγω ξανά 

και στο πάνελ Effect & Presets βρίσκω το εφέ Roughen
15 και για το scale 128. Αφού επιλέξω το εφέ Roughen

για αντιγραφή και επικόλληση στο κείμενο ΚΑΤΑΣΚΟΠΟΣ. 
Τώρα και το κείμενο θα έχει το ίδιο εφέ. (Fargas Studio, 2015). (Εικόνα 4-67) 

 
5-67 H  σφραγίδα τελική μορφή. 

και κλικ στο χρονόμετρο του πεδίου Level 
συμπληρώνω στο παράθυρο εκφράσεων 

Σφάλμα! Το αρχείο προέλευσης 

Σφραγίδα. Πηγαίνω 
που έφτιαξα, επιλέγω το 

κάνω αντίγραφο τη μάσκα και 
Μ για να μου εμφανίσει 

 16. Στη 
και σχηματίζω ένα κύκλο σε τυχαίο σημείο του 

. Δημιουργώ και άλλες κυκλικές 
μέχρι να υπάρχει το επιθυμητό 

, 2015)  

και γράφω στο κέντρο του 
. Ακολουθώ την ίδια διαδικασία με τις μάσκες με 
για να έχω το ίδιο οπτικό αποτέλεσμα. Επιλέγω ξανά 

Roughen Edges. 
Roughen 

για αντιγραφή και επικόλληση στο κείμενο ΚΑΤΑΣΚΟΠΟΣ. 
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4.13 ΕΞΑΓΩΓΗ ΒΙΝΤΕΟ  

Tο project έχει χωριστεί σε 21 ξεχωριστές σκηνές. Κάθε τελική σκηνή είναι 
ουσιαστικά και ένα composition που το κάθε ένα απαρτίζεται από πολλές άλλες 
συνθέσεις . Aφού έχω τελειώσει την επεξεργασία σε κάθε composition ξεχωριστά 
σειρά έχει να κάνω render για την τελική μορφή του σε βίντεο. Έχοντας ανοιχτό ένα 
composition (Adobe Creative Team, 2012, σσ. 359-361) πατάω πάνω από το 
Application menu Composition-> Add to render Queue ή την συντόμευση Ctrl+M. 

 
Εικόνα 4-68 Add to Render  Queue 

 
Στην συνέχεια κάνω κλικ πάνω στο πεδίο Output Model και ανοίγει το επόμενο 
παράθυρο. (Εικόνα 4-69) στο σημείο Format επιλέγω το format Mpeg4. 

 
Εικόνα 4-69 Επιλογή Format 

Τέλος τσεκάρω το πεδίο Audio Output για να ενεργοποιηθεί ο ήχος στο βίντεο 
και πατάω “ΟΚ”. Ρυθμίζω ακόμα το πεδίο “Output To”, το οποίο με καθοδηγεί σε 
ποιο σημείο θέλω να αποθηκεύσω το υλικό μου. Θα δημιουργήσω έναν φάκελο όπου 
θα αποθηκεύσω όλα τα τελικά μου βίντεο. Επιλέγω το κουμπί Render. Αυτή η 
διαδικασία ακολουθείται για κάθε composition. 

  

4.14 ΜΕΤΑΠΑΡΑΓΩΓΗ - ΜΟΝΤΑΖ ΣΚΗΝΩΝ  

Σε αυτό το στάδιο όλες οι σκηνές έχουν μετατραπεί σε βίντεο πλέον. Σκοπός 
είναι να συγκεντρώσουμε τα βίντεο για να μπούν σε μία διαδοχική σειρά και να 
ενώσουμε το υλικό για να βγεί ένα ενιαίο βίντεο.  

Σαν βήμα πρώτο θα περάσω όλα μου τα βίντεο μέσα στο Αfter effect. Στην 
συνέχεια θα ανοίξω ένα νέο composition και θα το ονομάσω “Η μηχανή του χρόνου” 
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όπου είναι άλλωστε και ο τίτλος του animation. Τοποθετώ με χρονική σειρά τα βίντεο 
όπως τα δημιούργησα. Τοποθετώ το τραγούδι μέσα στην σύνθεση και πατάω “Add  
To Render  Queue”. To animation είναι πλέον έτοιμο. 

 
 

 
 

 ΣΥΜΠΕΡΑΣΜΑΤΑ 

Στην πτυχιακή αυτή είδαμε την ιστορική αναδρομή, τις τεχνικές, την 
προετοιμασία που χρειάζεται πριν τη παραγωγή αλλά και τον τρόπο δημιουργίας ενός 
animation με την χρήση βοηθητικών προγραμμάτων.  

Το animation πριν από τους υπολογιστές ήταν χρονοβόρο και απαιτούσε 
οικονομικούς πόρους για την προμήθεια υλικών. Η εμφάνιση των υπολογιστών 
αρχικά βοήθησε στην δημιουργία γραφικών και εφέ στις ταινίες και όχι μόνο- που 
ήταν αδύνατο να συμβούν, μείωσε το κόστος παραγωγής και στην πορεία 
αντικατέστησε τις κλασσικές μεθόδους μέχρι τότε παραγωγής animation. 

Έγιναν σταδιακά βήματα για να μπορέσει ο καθένας να παρακολουθήσει πως 
δημιουργήθηκαν τα γραφικά, πως στήθηκε ο χαρακτήρας και τα σκηνικά, πώς 
προστέθηκε η κίνηση, τα εφέ και ο ήχος και τέλος πως έγινε το μοντάζ. 

Οι δυσκολίες ήταν αρκετές γιατί έπρεπε να αποκτηθούν γνώσεις για τα 
προγράμματα, χρειάστηκαν ώρες δοκιμών μέχρι να επιτευχθεί το επιθυμητό 
αποτέλεσμα αλλά και μεγάλη συγκέντρωση στην επεξεργασία κάθε σταδίου 
παραγωγής. Επιπλέον διαπιστώθηκε ότι για εργασίες τέτοιου είδους χρειάζεται 
μεγάλη υπολογιστική ισχύ γεγονός που δυσκόλεψε αρκετά την επεξεργασία του 
βίντεο σε διάρκεια χρόνου και περιόρισε οπτικά το αποτέλεσμα σε σχέσεις με τις 
αρχικές προσδοκίες.  

Συμπερασματικά, αποτελεί ένα ενδιαφέρον πεδίο το οποίο απαιτεί οργάνωση 
και μεθοδικότητα, συνεργασία και ομαδικό πνεύμα όταν πρόκειται για μεγάλες 
παραγωγές, δημιουργικότητα και πολλές γνώσεις των πεδίων που καλύπτει. 
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